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Preface  
 

This manual provides installation, setup and operating instructions for 360 Systems’ MAXX Image 
Server™.  It is organized to provide quick access to topics of primary interest.  An extensive Table 
of Contents is provided at the beginning and a subject Index at the end, to assist in locating 
information. 

If you have already used hard disk video servers (or VTRs), you may find discussion of the basic 
server to be covering familiar topics.  However, it is strongly recommended that engineering 
managers and staff members operating the Image Server read through this manual.  Being familiar 
with its operation can prevent operational mistakes, and will make all users aware of important set-
up and maintenance issues.  

Software and Operations Manual Revisions 
Software revisions are released from time-to-time that introduce new product features, or improve 

the performance of the product.  When such revisions are shipped in the form of a CD-ROM, 
printed operational notes will be included.  When revisions are introduced in the course of product 
production, an updated Operations Manual will be shipped with new servers.   

The title page of an Operations Manual indicates its revision number, which should always match 
the software revision of the server with which it is used.  Operations Manuals for the latest revision 
may be obtained from 360 Systems Customer Service, or from 360 Systems’ web site.  

Your comments are welcome.  If anything in this manual seems unclear, please let us know by 
sending an email to support@360systems.com.  

 

Typographical Conventions 

The following typographical conventions are used to clarify meaning: 

• Connector or indicator labeling that appears on the unit is shown in Arial Narrow BoldArial Narrow BoldArial Narrow BoldArial Narrow Bold. 
• GUI menu items are shown in Arial Bold. 
• Test typed into the GUI and Key Commands are shown in Courier Bold. 

• GUI sub-menu paths are shown by the > symbol. 
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Safety Notices 

Safety Terms and Symbols 

THE FOLLOWING WARNING SYMBOLS ARE USED IN THIS MANUAL: 

ENGLISH ATTENTION:  REFER TO OWNER’S MANUAL FOR IMPORTANT 
INFORMATION. 

FRANÇAIS ATTENTION:  VEUILLEZ VOUS RÉFÉRER AU MODE D’EMPLOI 
POUR UNE INFORMATION IMPORTANTE. 

ITALIANO ATTENZIONE:  FATE RIFERIMENTO AL MANUALE PER 
INFORMAZIONI IMPORTANTI. 

 

ESPAÑOL ATENTCION:  FAVOR DE REFERIR AL MANUAL DE 
OPERACION POR INFORMACION IMPORTANTE. 

 

ENGLISH WARNING:  ELECTRICAL SHOCK HAZARD. 

FRANÇAIS AVERTISSEMENT:  DANGER DE CHOC ÉLECTRIQUE. 

ITALIANO AVVERTIMENTO:  PERICOLO DI SHOCK ELETTRICO. 

 

ESPAÑOL ADVERTENSIA:  PELIGRO DE CHOQUE ELECTRICO. 

General Safety Caution 

• Heed the following important cautions regarding the Image Server in order to avoid personal 
injury or equipment damage. 

• Only qualified personnel should perform installation and service.  Refer to appropriate sections 
of this product manual for instruction.  Contact 360 Systems Customer Support for further 
explanation, or to clarify any uncertainty. 

• Disconnect the power cord before removing the cover. 

Personal Injury Precautions 
To avoid electric shock, do not operate this product with covers removed. 
To avoid risk of fire, replace the power cord only with same type and rating as specified.  Replace 
damaged power cords immediately. 
This product is grounded through the grounding conductor of the power cord.  To avoid electric 
shock, do not remove or modify the contacts on the plug. 
Prevent the power cord from being walked on, pinched, or abraded. 
To reduce the risk of fire or electric shock, do not expose this unit to rain or moisture. 
Remove jewelry, such as rings, watches, or necklaces before servicing this equipment. 
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Product Damage Precautions 
• Image Server recorders contain hard disk drives and other fragile electronic and mechanical 

devices.  While this product is very reliable, it is still vulnerable to shock.  Handle it with care, 
and exercise caution not to drop or bump the recorder as damage to internal components may 
result.  Turn off power before moving the server. 

• Do not obstruct air vents.  Maintain an ambient temperature below 30°C (86°F). 

• Clean only with a soft cloth dampened with water.  Do not spray cleaners or solvents directly 
on the product. 

 CAUTION: 

Replace battery only with the same, or equivalent, battery type.  Follow all local laws 
regarding the disposal of BR and CR Lithium batteries.  Batteries should be fully 
discharged prior to disposal. 

 CAUTION: 

Never use the rear-panel power supply switch to shutdown the Image Server.  Doing so 
may cause errors in the hard disk array.  Should this happen, the array can be 
reinitialized without any data loss; however, the process may take several hours.  
Shutdown the system only by momentarily pressing the front panel power button, or 
through the On-Screen user interface. 

Product Registration 
Important: As the owner of new capital equipment, you will want to take advantage of product 
information, enhancements, upgrades, or notifications issued by 360 Systems.  Send in your 
Warranty Card so 360 Systems can remain in contact with you.  Mail or fax it to 360 Systems 
offices in the USA at the address given below. 

Product Improvements and Upgrades 
360 Systems reserves the right to make changes and/or improvements to its products without 
incurring any obligation to incorporate such changes or improvements in units previously sold.  
Certain features mentioned in this document may not be present in all models.  Image Servers are 
not offered for sale in all countries. 

Trademarks 
MAXX Image Server, Multi-Format Image Server, 360 Systems, 360 Systems Broadcast, Bit-for-Bit, 
and Direct Digital Import are trademarks or registered trademarks of 360 Systems in the U.S. and/or 
foreign countries.  Other trademarks referred to in this document are the property of their 
respective owners. 

Software Copyrights 
Software in this product is based on the work of, or is copyright by, 360 Systems, SuSE® GmbH, 
Trolltech, and FreeType Team.  Copyright 2003-2009 by 360 Systems. 

Video and Audio Copyright Reminder 
It is illegal to use this product to make copies of copyrighted material without the express 
permission of the copyright holder 
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Introduction 
 

360 Systems’ MAXX Image Server™ is a multi-channel video recorder/server designed for television 
broadcast and production applications.  It can play three independent video streams at once, and 
store up to 450 hours of MPEG-2 video, with four audio channels per video stream.  It occupies 
just 3½” of rack space.  The server’s extensive feature set makes it an excellent choice for VTR 
replacement, broadcast automation, remote trucks; production for PEG, corporate and house-of-
worship video; and live entertainment presentations.  Image Server MAXX is produced in separate 
NTSC and PAL models.  References in this document to frame counts other than 29.97 or 30 
frames should be understood as a PAL example.  

The Transition to a Digital Plant 
Image Server MAXX smoothes the transition to digital production and broadcasting by providing 
both composite video and serial digital (SDI) interfaces, plus program file transfers over Gigabit 
Ethernet. It’s never necessary to add outboard video A/D or D/A converters or MPEG encoders; 
premium-quality codecs are included as standard equipment.  The server’s dual analog and digital 
personality—for both video and audio—makes it fit seamlessly into an existing analog facility, or 
become part of a new digital build-out. Apart from serving its intended purposes, Image Server 
MAXX is also valuable for its ability to convert between different analog and digital media formats 
in real-time. 

Exceptional Storage Capacity 
The Image Server’s program storage is scaleable to suit the needs of both small and large users.  It 
houses four hard drives within its compact enclosure, providing from 112 to 450 hours of storage 
at 12 Mb/sec.  Storage time is proportional at other data rates.  The server’s RAID-5 disk array 
provides a high level of security for stored programs.  By spreading parity information across all 
drives, the RAID array helps keep the server in service—even with a failed drive.  The multi-drive 
storage array also generates the high data rates needed for multiple video streams at up to 50 
Mb/sec, and enables fast program transfers through the Gigabit Ethernet port. 

Drive Size Storage Capacity 
(4 drives) 

Time @ 12 Mb/s 
2 audio channels 

Time @ 8 Mb/s 
2 audio channels 

250 GB 1.0 TB 112 hours 150 hours 

400 GB 1.6 TB 170 hours 250 hours 

500 GB 2.0 TB 220 hours 300 hours 

1000 GB 4.0 TB 450 hours 600 hours 

IMAGE SERVER MAXX STORAGE TIMES 

 
The Image Server’s unique ability to play two video streams while recording a third, and at the 
same time do file transfers over Gigabit Ethernet, make it far more than just a VTR replacement. 

Image Servers Support Traditional VTR Functions  
The Image Server is a perfect drop-in replacement for popular VTRs.  It saves costs for tape, 
machine maintenance, cassette prep, and storage.  Its three output channels perform any 
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combination of tasks, including responding to GUI or automation commands, clip trimming or 
browsing. 
Unlike a VTR, the Image Server can simultaneously record and play a program.  A new recording 
can start at any time, even when two simultaneous playbacks are in progress.  As a VTR 
replacement, the Image Server is controlled through a 9-pin serial interface.  Several serial 
protocols are supported, allowing the Image Server to immediately operate with the controllers you 
already own. VDCP and Odetics protocols provide very complete server control, including editing 
functions. Sony BVW protocol is also provided in an abbreviated form allowing basic machine 
control, without insert-editing.  Six parallel “GPI” control channels are also provided. 

Compatibility with Automation Controllers  
Image Servers work with automation controllers from many different manufacturers. They use 
established VDCP and Odetics protocols allowing 9-pin control of each server channel, for 
maximum flexibility.  360 Systems’ automation partners provide controllers for applications 
ranging from affordable systems for Pro-AV, up to large-scale broadcast solutions. Contact a 360 
Systems application engineer, or an automation provider for assistance with your requirements. 

Remote Controls 
Hardware accessories are available from third-party manufacturers to perform transport control, 
trimming, clip replay and playlisting (automation).  A table of approved controllers is provided 
elsewhere in this manual. Contact 360 Systems Sales Support team for assistance with a specific 
application. 

The Image Server provides six GPI inputs for remote play, stop, and record capability from push-
button panels or other GPI-controlled equipment.  Six outputs are also provided; these may be 
used for command acknowledgement (to drive LEDs or logic inputs), or may output commands 
embedded within an Advanced Playlist on the Image Server. 

Extended Feature Set 
Image Server MAXX encodes video in MPEG-2 format, in 4:2:2 Profile with data rates to 50 
Mb/sec, or in Main Profile to 15 Mb/sec.  Both I-frame and long-GOP formats are supported.  
MPEG-2 file transfers in MXF-format are compatible with servers from other market leaders. MAXX 
can also receive IMX (D-10) files in the MXF format from Sony EVTRs. 

The DV and Graphics capability allows Direct Digital Import™ of DV-25 and TARGA files to an 
Image Server over an Ethernet connection. DV files may then be trimmed, playlisted, stored, 
played out, and re-exported over Ethernet.  They remain in DV format at all times, and are not 
converted to MPEG.  TARGA files may be imported to the Image Server, and will be converted into 
separate high-resolution MPEG-2 “key” and “fill” files.  These can be played as a synchronized 
pair, for downstream compositing.  

Audio Features 
Image Servers include both analog and digital audio circuits, making it an easy fit when upgrading 
a facility.  Gold XLR connectors are used for audio inputs and outputs.  Each output can be 
configured for either AES/EBU digital or +4 dBu balanced analog.  In discrete digital format, each 
video program can have four channels of audio, whereas analog I/O provides two channels.  (An 
AES/EBU line on a single XLR connector carries two audio channels, so a given number of XLR 
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connectors make more channels possible in digital format).  SDI embedded audio is also included 
as standard equipment. 
360 Systems brings extensive experience in broadcast and pro-audio to the design of Image 
Servers.  They employ a 24-bit word, and deliver a 20 dB improvement in SNR (10 times!) 
compared with older 16-bit audio systems.  A sample-rate converter is included in the audio input, 
which may be inserted from the GUI.  Input circuits provide excellent hum and RF rejection, and 
20 dB of headroom.  360 Systems’ Bit-for-Bit® design strategy assures that Dolby®-E, Dolby AC3, or 
other forms of encoded audio will be stored and played correctly.  

On-Screen Graphic User Interface 

The Image Server’s On-Screen graphic user interface (GUI) gives fast access to all server functions. 
It is controlled by a standard keyboard and mouse (supplied) and requires only a VESA-compliant 
SVGA display.  

The GUI displays a complete control panel for each server channel; these include transport control, 
clip file management and head and tail trimming.  The GUI allows an Image Server to operate as 
three self-contained VTR equivalents. 

System configuration is clear and straightforward with the GUI.  It provides access to MPEG-2 
encoding parameters, audio channel and time-code settings.  Whenever new server features are 
installed (using the built-in CD-ROM drive) new set-up parameters and user-interface features 
become immediately available. 

Remote Workstation Software allows the GUI to be remotely operated from a common Windows® 
PC connected by Ethernet.  Separate work areas can be easily created within a building for ingest, 
trimming, playlisting, system monitoring or play-to-air.  

File Transfers over Gigabit Ethernet 
Image Servers go beyond providing just base-band connections for video and audio.  Both DV and 
MPEG-2 file transfers over Gigabit Ethernet open the door to new IP solutions for transferring video 
across the room—or across the country—at high speed and low cost. 

By adding economical Ethernet switches  and broadband connections, the Image Server’s design 
enables low-cost networking of broadcast operations from ingest to storage, for editing, play-to-air 
and archiving.  The Image Server moves programs many times faster than real time, saving time 
and streamlining operations. 

360 Systems’ MXF implementation for MPEG-2 transfers uses Operational Patterns 1a and 1b.  It 
has been tested for compatibility with MXF files from many other manufacturers.  360 Systems can 
make Image Server MXF files available for testing and evaluation through our FTP site.  Contact the 
customer service department to arrange for access.   

Reliability Counts 
360 Systems has 37 years experience manufacturing equipment for television broadcast and other 
industries that require elevated reliability.  We understand quality and reliability, and have given 
close attention to design issues like power, cooling, and protecting stored data.   
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Key Features and Benefits 
Image Server MAXX is designed from the ground up to deliver outstanding performance and value 
in a multi-channel MPEG-2 and DV-format server.  Three video outputs with analog, digital, and 
Gigabit Ethernet interfaces make it an excellent choice for the next-generation plant. 
 

• MPEG-2: Main Profile @ Main Level and 4:2:2 Profile @ Main Level to 50 Mb/s. 

• Import and playout of DV video and TARGA graphics  

• Drag-and-Drop DV transfers from popular desktop editing programs 

• Internal RAID-5 storage configurable up to 450 hours 

• Three simultaneous video outputs, or 1 video input and two outputs 

• SDI and composite video inputs and outputs 

• Balanced analog and AES/EBU digital audio ports  

• Four audio channels (2 AES stereo pairs) for each video channel 

• Embedded audio 

• Serial control via VDCP, Sony BVW or Odetics protocols 

• Compatible with leading broadcast automation systems 

• Fast FTP transfers on Gigabit Ethernet  

• VITC time code  

• LTC Time code input and output; VITC written and read 

• Accurate head and tail trimming 

• Advanced Playlisting: Build, edit, store, playback, and loop multiple lists 

• Looping 

• Closed-Captions 

• Keyboard shortcuts for editing  

• Set-up, administration and control via graphic user interface 

• Remote Workstation Software for Windows computers available  

• 31-character file names 

• Compact 2RU (3½”) [88mm] enclosure, low power consumption 

• Low cost 
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Applications for 360 Systems Image Servers 
Image Servers add value to many applications in broadcasting, cable distribution, video 
production, Pro A/V, entertainment and sports venues.  Many of these tasks are impractical with 
videotape.  In contrast, an Image Server provides immediate record and playback of any source, 
and lends a spontaneous appearance to broadcasts, presentations and live events. 
 

• News Production – Promos, teasers, intros, news segments, graphics, animation 

• Graphics Server – Play TARGA files with key-and-fill 

• Master Control – Program and commercial playout, station IDs, promos, teasers 

• Program Ingest – Automated capture of satellite, tape, microwave, and fiber feeds 

• FTP File Delivery – Deliver news, promos, spots over DSL or ATM lines 

• Play-to-Air Server – Playback under automation control 

• Program Store-and-Forward – Temporary storage for subsequent delivery  

• Commercial Insertion – Playout under automation control 

• Instant Replay – Hot Key playback of sports plays, news clips, stills, and graphics 

• Sports Shows and Events – Player bios, animations, graphics, promos 

• Game Shows – Prizes, graphics, animations, promos 

• Talk and Variety Shows – Promos, teasers, intros, outros, graphics, animations 

• Award Shows – Nominees, categories, promos, graphics, animations 

• Theme Parks and Casinos – Playout for show backgrounds, event lists, kiosks 

• Houses of Worship --  Projection displays, program production, broadcasting 

• Colleges and Universities – On-campus networks, production, presentations 

• Digital Signage – drive projectors, flat-panel displays, kiosks 

• Entertainment Industry – Road show displays, projection 

• City Governments, Public Access – Long recording times, high quality video 

• Mid- Market Broadcast– High performance at an attractive price 
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Available Models 

 

MAXX Image Server  Model MAXX-250 
Provides 112 hours of storage at 12 Mb/sec. 
 

MAXX Image Server  Model MAXX-400 
Provides 170 hours of storage at 12 Mb/sec. 
 

MAXX Image Server  Model MAXX-500 
Provides 220 hours of storage at 12 Mb/sec. 
 

MAXX Image Server  Model MAXX-1000 
Provides 450 hours of storage at 12 Mb/sec. 
 

Storage Upgrades 
Upgrades an Image Server MAXX up to 450 hours of storage (at 12 Mb/sec).  Field installable. 
 

PAL Models 
Add suffix PAL to model number when ordering. Specify mains cord required. 
 

Maintenance Spares  
360 Systems is committed to keeping your Image Server on air.  The server contains hard disk 
drives and other fragile electronic devices; and while it is designed to be very reliable, having spare 
parts on hand in the event of a fault is a good practice.  Hard disk spares are particularly important. 
Please consider these important options at the time of your purchase, or shortly after. 

• 250 GB Image Server Hard Drive for 112 hour servers 

• 400 GB Image Server Hard Drive for 170 hour servers 

• 500 GB Image Server Hard Drive for 220 hour servers 

• 1000 GB Image Server Hard Drive for 450 hour servers 

• Image Server Power Supply, universal line voltage 
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Installation 

Unpacking 
Your Image Server has been carefully inspected and calibrated before shipment to allow immediate 
operation upon installation.  Check all items for signs of visible damage which may have occurred 
during shipment.  If any item is damaged, contact the carrier to file a claim. 

Keep the packing materials in the event that a unit must be shipped by you.  If the original 
packaging is not available, make sure that the following criteria are met: 

• Packaging must be able to withstand the product weight. 
• Product must be held firmly within the package. 
• There must be at least two inches (50mm) of space between the product and outer container. 
• The corners of the product must be protected. 

 

Package Contents 
Confirm that all items on the packing list have been received.  Contact 360 Systems if any item is 
missing. 

� Image Server MAXX 

� Keyboard 

� 2-Button Scroll Mouse. 

� Software CD-ROM backup copy 

� Remote Workstation Software CD 

� Rack Mount Hardware Kit 

� Operations Manual 

� Power cord 

� Warranty Card 

 
The Image Server is not shipped with a video monitor.  Select a VESA-compliant CRT or LCD 
monitor with a minimum refresh rate of 75 Hz.  Note that the Image Server may not start 
correctly if an unsuitable monitor is connected. 

If you own more than one Image Server, it may be appropriate to use a single keyboard, monitor, 
and mouse with a KVM switch to select between servers. Not all KVM switching systems are 
compatible.  The KVM switch must supply an active signal to the Image Server at all times, even 
when switched away from it.  When first powering up the Image Server, use only the supplied 
keyboard and mouse directly connected.  Then test the KVM switch system that will be used 
thoroughly before installation is completed. NOTE: If the mouse and keyboard connections are 
interchanged, the Image Server may not boot up properly. Be especially careful about this when 
using extender cables. 
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Rack Mounting 
Note: If you plan to use digital audio, be sure to change the configuration of the Analog/Digital 
Audio Jumpers inside the unit before mounting the Image Server in a rack.  The jumpers are factory 
set to the Analog audio position.  For more information about changing the jumpers, see 
Analog/Digital Audio Selection on page 109. 

There are four adhesive-backed rubber feet on the Image Server.  These may need to be removed 
when rack mounting the unit. 

In North America, the Image Server will usually be mounted in a 19” rack enclosure having 10-24 
or 10-32 tapped holes.  In countries with metric standards, the user will need to supply appropriate 
fasteners. 

Cables attached to the rear of the Image Server should be supported by the rack mounting rails.  
Do not support substantial cable weight from the Image Server. 

Remove the front panel to expose the rack screw slots.  Fasten the Image Server into the rack using 
#10 flat-head Phillips screws (provided in North America).  Replace the front panel.  Tighten the 
front panel access screws. 

Important Installation Notes 

System Cooling 
When many pieces of equipment are mounted in an equipment rack, a considerable amount of 
heat may be produced, which must be removed efficiently.  Further, a lower operating temperature 
will make equipment operate more reliably, and it will last longer.  In the extreme case, excessive 
temperatures cause rapid equipment failure, and damage which can be difficult to repair.    

Heat in an equipment rack should be removed by forced air.  This is often accomplished by 
blowers installed in the top of the rack, venting into the room.  An alternative is to draw hot air 
from the top of the rack into an air-conditioning return duct, and not vent it into the equipment 
room; cold air should be ducted into the bottom of the rack. 

The optimum air temperature for cooling electronic equipment is 25° C (72° F).  When many 
pieces of equipment are contributing to the heat load, a substantial air-flow will be needed, and the 
inlet temperature may need to be lower. 
 

Check These Points 

• Are all ventilation holes in the Image Server free of obstruction? 

• Can blowers or HVAC system adequately remove heat from the equipment rack? 

• Have you measured the actual temperature inside the rack? Do this near the top. 

• Verify that the HVAC system is not on a timer that can shut off on weekends or holidays. 

• What procedures are in place to protect the equipment when the HVAC system fails? 
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Important Installation Notes 

Power Conditioning 
It is good practice to operate an on-air video server from an Uninterruptible Power Source, or UPS.  
All utility power systems experience occasional transient events, including brownouts and 
dropouts, which are capable of taking a server off the air.  It is the station operator’s job to plan for 
and overcome such contingencies. 

UPS units suitable for smoothing short-term power line problems come in two varieties:  

Change-over UPS Design  

This design senses drop-outs and low-line voltage, and switches its output to an internal inverter 
operating from a battery.  This UPS is low in cost, and is most often used in non-critical 
applications such as desk-top computers.  A disadvantage is that it may create its own power 
transients when switching between utility power and its inverter supply. . For this reason 360 
Systems does not recommend this type for use with Image Server. 

Continuous Conversion UPS Design 

This improved design continuously converts utility power to DC, stores it in a battery, then 
produces isolated AC power from an inverter.  It never switches, and is immune to input transients, 
brownouts, and blackouts.  Models are available with batteries of almost any size, making the 
continuous-conversion UPS suitable for transient suppression or long-term operating power in the 
absence of utility power. 

Recommended UPS Models 

The following makes of continuous conversion UPS systems are suitable for use with 360 Systems’ 
Image Server products: 

APC Smart-UPS 2200-XL 

Eaton/Powerware Corporation, Model 9125, www.powerware.com 

This unit is available in several different configurations to accommodate various current 
load and power failure support times.   

The minimum requirement for maximum current load for a single MAXX is 2 amps. 
 

Operating Environment 

A video server is the most critical element in a broadcast operation. Its installation should safeguard 
it from every external event that can interfere with it doing the task expected of it.  360 Systems’ 
engineers have experience with thousands of installations, and have become aware of a number of 
environmental factors that can adversely affect performance. Two of these have already been 
discussed: power conditioning and inadequate cooling.  Two others, less obvious, should also be 
considered: 
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Important Installation Notes 

RF Interference by Cell Phones 

Many people are not aware that cell phones can attain a very substantial power output, even when 
no conversation is taking place. You may have experienced the effect of a cell phone interfering 
with a common desk phone placed nearby.  Carrying a cell phone into a machine room where it is 
in close proximity to broadcast equipment and its associated wiring is unwise.  They are able to 
interfere with serial control commands, video synchronization, and in some cases can crash the 
CPU in equipment. 

Some major broadcasters prohibit the carrying of cell phones into certain machine areas. 360 
Systems believes that the risk of undesired equipment behavior from their RF fields is very real. 

 

Static Discharge 

Static electricity discharge is accepted by most people as an inevitable consequence of living in a 
dry area.  It is, rather, a result of floor coverings that may enhance appearances, but are 
inappropriate for use around critical pieces of broadcast equipment. Static discharge can do two 
adverse things:  

• Discharge into a connector can—and will—destroy internal circuitry of equipment.  The result 
will always be difficult to diagnose and repair.  

• Discharge to equipment frames or wiring can crash a CPU and take the station off the air. The 
event may seem random or unrelated to static, but it is clearly a catastrophic event—and one 
that can repeat indefinitely as humidity varies.  

Several steps can be taken to protect equipment from static discharge: 

• Do not install critical broadcast equipment (video servers) in a room with carpeting.  

• Connect equipment racks directly to an earth ground with a heavy copper conductor. 

• Do not operate equipment with a lifted safety ground (green frame ground). 

• Install a humidifier to reduce the level of static discharge. 

About Image Server Software 
The Image Server is shipped with its application programs and operating system installed. 

The first time that it is started, it must be connected to a keyboard, monitor and mouse.  The Image 
Server will ask you to accept the Software Licensing Agreement before it will operate.  This screen 
will only appear during the initial startup. 

The CD-ROM drive is intended only for installing software.  It may not be used to load video or 
audio program content. 

If for any reason it becomes necessary to reinstall any software, refer to the Maintenance chapter 
for instructions. 
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Image Server Hardware Interface 

Front Panel Features 
 

 
 

Power ON/OFF button 
The blue front panel button initiates start-up and shut-down of the Image Server.  Press it 
momentarily to start the server.  A sequence of start-up screens will appear, ending with the 3-
channel graphic user interface. 

When the Image Server is running, pressing the blue button momentarily will cause the system 
to begin an orderly shutdown.  This can also be initiated from the GUI by selecting  
START > SHUTDOWN > SHUTDOWN. In most cases the power will shut off automatically, 
however if the front panel lights begin to blink the file system has been properly closed and it is 
safe to force the power off by holding the front panel button in for 4 seconds. 

In the event that the system has stopped responding to commands and will not shutdown, hold 
the button in for 4 seconds to force a power down. 

Do not use the rear panel switch on the power supply to shut down the Image Server.  Abrupt 
power loss can cause loss of information stored on the disk array. The rear panel power switch 
can be used to prevent re-application of power during service procedures once the normal shut 
down sequence is complete. 

CAUTION: 
LOSS OF DATA CAN OCCUR IF THE POWER IS TURNED OFF WITHOUT A SHUTDOWN. 

USE THE FOUR SECOND SHUTDOWN ONLY IF THE SYSTEM IS NOT RESPONDING OR 
THE SHUTDOWN PROCESS DOES NOT TURN THE POWER OFF AUTOMATICALLY.  

Indicators 
Five blue LED Status Indicators appear on the front panel.  The POWER, FANS, DRIVES and 
SYSTEM indicators are illuminated continuously when the system is functioning normally. 
GENLOCK will be off when Internal Sync is selected, and illuminated when Genlock is 
selected. See the table Front Panel Indicators on page 105 for diagnostic meanings. 
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Rear Panel Features 

Video Inputs 
The Image Server records video on channel #1.  It has separate BNC inputs for SDI (serial 
digital per SMPTE 259M) and analog video (CVBS) signals.  Both video inputs have a fixed 75-
ohm termination. The graphic user interface selects between the two.  Encoding is performed 
in MPEG-2 format within the server.   

Video Outputs 
Video outputs are provided in SDI and Composite (CVBS) formats simultaneously.  Digital 
video appears in SDI format at 270 Mb/s and conforms to SMPTE 259M.  Analog video is 
composite (CVBS). 

Audio I/O 
The Image Server provides audio inputs and outputs in three formats: 

• Balanced analog audio at a reference level of +4 dbu. 

• Digital audio in AES/EBU format per AES-3-2000. 

• SDI embedded audio, 4-channels 

These multiple standards facilitate the transition from an analog studio to digital production and 
broadcasting, and ensure that the server can operate with most equipment.  Note that both 
analog and AES/EBU audio signals are not available at the same time on a given input or 
output.  Internal jumpers select between analog or digital; however, each pair of inputs and 
outputs can be set up differently, if desired.  A set of XLR-3 connectors allows high-quality 
connections to be made in either format.  Embedded audio appears in the SDI output stream at 
all times. 

Analog Audio Capability  

When the analog audio input format is selected, each video channel has two audio channels, 
recorded together as a stereo pair.  Internal trimmers allow adjustment to unity gain. 

Digital Audio Capability 

When AES/EBU digital audio is selected, each video channel has four audio channels, which 
are recorded as two stereo pairs.  Because a single XLR connector carries a stereo pair in 
AES/EBU format, and only one (monaural) channel in analog, the server provides an extra pair 
of audio channels when used with AES/EBU audio signals. 

Embedded Audio Capability 

When SDI embedded audio is selected, four audio channels are available for recording. 
Embedded audio is always inserted in the video outputs. Note that discrete audio (analog or 
AES/EBU) is also available on XLR connectors, at the same time embedded audio appears in the 
video stream.  Embedded audio has a 20-bit resolution. 
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Audio Word Size and Sample Rate  

The Image Server employs 24-bit audio A/D and D/A converters, and records audio into a 24-
bit frame, regardless of the word size received.  The sample rate is fixed at 48K.  When using 
the AES/EBU digital input, the 48K sample rate of the incoming digital audio must be derived 
from the video genlock reference.  If it is not, or if a different sample rate is used, the Image 
Server’s input sample rate converters must be selected. 

Encoded audio streams such as Dolby E® must be referenced to the video genlock, and the 
input sample rate converters must be disabled when recording such streams. 

Analog/Digital Audio Selection 
The following drawing illustrates jumper positions to select between analog or digital audio.  
Note that each output may be individually selected.  As described earlier, when analog audio is 
selected, only two channels are available, while selection of AES/EBU digital audio provides 
two stereo pairs, one on each XLR connector.  Both jumpers for each channel (Left & Right, or 
Main & Aux) must be set together, either analog or digital.  The Image Server must be power 
cycled for jumper changes to take effect.  For more detail, see Analog/Digital Audio Selection 
in the Maintenance chapter. 

DIGITAL

ANALOG

JUMPER BLOCK PAIR SHOWN

IN ANALOG POSITION

JUMPER BLOCK PAIR SHOWN

IN DIGITAL POSITION

GAIN ADJUST

 

Figure 1: Jumper location on audio card for selection of analog or digital audio. 

Serial Control Ports 
Each of the Image Server’s three 9-pin “D” connectors permits independent control of any of 
the three video channels.  They can accept serial commands in VDCP, Sony BVW or Odetics 
protocol.  The multiple serial ports allow simultaneous connection of an automation controller 
and a desktop controller.  See the chapter on Automation Control for further details. 

Most broadcast automation systems, and some remote control panels, employ the VDCP 
protocol.  A list of supported VDCP commands will be found in Appendix B. 

Many controllers used for transport, instant replay, and edit control employ Sony BVW or 
Odetics protocol.   
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Gigabit Ethernet Port 
Gigabit Ethernet ports are provided on the Image Server.  The NET 1NET 1NET 1NET 1 port is intended for 
external transfer of program content between video servers.  The server supports MXF file 
transfer (MPEG-2, Op 1a and 1b), which allows content interchange between products from 
different manufacturers, as well as file import in various formats from desktop editors.  

The NET 2NET 2NET 2NET 2 port is reserved for future use and is not active.  Use only the NET 1NET 1NET 1NET 1 port. 

GPI Control 
The Image Server provides six GPI inputs for control of machine functions, which appear on 
the 25-pin GPIGPIGPIGPI connector.  This “General Purpose Interface” can be connected to switch 
contacts or an open-collector transistor output.  GPI inputs are programmable, and can provide 
machine control such as PLAY, STOP, or RECORD through simple external switches. 

The Image Server also provides six GPI status outputs which may be used to confirm that a 
command has been received, or for other purposes.  The functions of these open-collector 
outputs are programmable, and may be used to operate an LED, or they can be connected to a 
suitable logic input.  The pin-out for the GPI connector will be found in Connector 
Specifications. 

Genlock Sync Reference 
A BNC connector is provided on the rear panel to receive a genlock signal.  During normal 
operation, the Image Server should be referenced to an external genlock reference in the form 
of CVBS black.  As with all video systems, this server and equipment connected to it must be 
referenced to a common genlock source.  The GENLOCKGENLOCKGENLOCKGENLOCK input provides a fixed 75-ohm 
termination. 

An internal crystal reference is also provided so that the server can be used as a stand-alone 
player, and also for convenience in performing tests in the laboratory.  Use particular care 
when operating the server with an internal reference, as synchronization with other equipment 
is not possible.  

Genlock Signal Quality 

A genlock signal connected to the Image Server must conform to the RS-170A standard.  PLL 
circuits used within the server remove residual jitter from the genlock signal.  This may 
preclude the use of low-cost VCRs as signal sources, as they may introduce time instability 
(wow) into their output, making them inaccurate as a genlock source. 

LTC Time Code Input 
A LTC time code input is provided on the LTC INLTC INLTC INLTC IN BNC connector.  This input may be selected 
by means of the On-Screen user interface and recorded as a time code reference.  The LTC 
input provides a >10k ohm termination. 
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LTC Time Code Output 
An LTC time code output is provided on the LTC OUTLTC OUTLTC OUTLTC OUT BNC connector.  It may be selected by 
means of the On-Screen user interface to output time code from any of the three video 
channels during playback.  The LTC output has a source impedance of <5 ohms. 

Keyboard 
Attach the alphanumeric keyboard to the purple 5-pin KEYBDKEYBDKEYBDKEYBD connector to control the server 
and manage clips with the On-Screen graphic user interface.  Note that the server will only 
recognize the keyboard if it is attached before power up.  

Mouse 
A two-button scroll mouse is provided with the Image Server.  Plug the mouse into the green 5-
pin MOUSEMOUSEMOUSEMOUSE port.  Do not use the USB ports, even if the supplied mouse is USB capable. Note 
that the server will only recognize the mouse if it is attached before power up. 

Monitor 
A VESA-compliant computer monitor may be connected to the 15-pin VGA video port.  The 
Image Server resolution is fixed at 1024 x 768 pixels, with a refresh rate of 72 Hz.  This is best-
viewed on 17-inch or larger monitors.  360 Systems does not provide monitors for the server.  
Note: Do not use older monitors that are not VESA compliant.  The server may not start 
properly if an unsuitable monitor is connected. 

Serial Port 
The system board serial port is not used.  Make no connection. 

USB Ports 
The system board USB ports are not used.  Make no connection. 

Power 
An IEC mains socket is provided on the rear panel for power input.  The Image Server will 
accept world-wide power sources in the range of 100-240 volts AC, 50-60 Hz.  The server is 
shipped with a power cord appropriate for the region in which it is sold.  Replace the power 
cord only with one of the same type and rating. 

DO NOT use the power supply switch to shutdown the Image Server.  (See the section 
Shutting Down Image Server on the next page.)  The rear panel power switch should only be 
used if the Image Server fails to shutdown after holding the front panel power switch for 4 
seconds, and the shutdown procedure from the GUI is not possible.  The rear panel power 
switch can be used to prevent the application of power during service procedures once the 
normal shutdown sequence has completed. 
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Basic Operations 
This section introduces the Graphic User Interface (GUI), its menus and operating controls.  If you 
want to skip ahead to learn how to record a clip, go to page 35.  Skip to page 41 to read about 
playing a clip. 

The graphic user interface is a convenient way to manage Image Server operations.  With it, you can 
control recording and playout, set up video and audio formats, map remote control ports to video 
channels, perform editing and make playlists.   

All GUI software is pre-installed on the Image Server.  It is also contained on the Image Server 
software CD-ROM.  The GUI is operated with a keyboard, mouse, and monitor connected to the 
Image Server rear panel.  During the first power on the system must be connected to a keyboard, 
monitor and mouse.  The Image Server will ask you to accept the Software Licensing Agreement 
before it will operate.  This screen will only appear during the initial startup. 

The Image Server Desktop 
The Image Server desktop is similar to many computer graphic interfaces, and is always running.  A 
task bar and start menu appear at the bottom of the screen.  Use the Start menu button to launch 
applications, manage the system or to shut down the server. 

Launching the Graphic User Interface 
The GUI launches automatically during boot up.  If it has been closed, click Start, then Image 
Server GUI to re-launch it.  The GUI window can be moved or minimized as desired. 

Shutting Down Image Server 
Click Start, then Shutdown, then select either Shutdown to begin an orderly shutdown, or Full 
Restart to do an orderly shutdown and Restart (without a full power down). 

Alternatively, momentarily pressing the front panel power button will cause the system to begin an 
orderly shutdown.  Image Server will acknowledge the button press with an audible beep and the 
front panel lights will begin to flash together.  Any operation in progress will be halted, and any 
unsaved work will be lost. 

In most cases the power will shut off automatically.  However, if the front panel lights begin to blink 
the file system has been properly closed and it is safe to force the power off by holding the front 
panel button in for 4 seconds. 

In the event that the system has stopped responding to commands and will not reset by pressing the 
front panel button, press and hold the button for four seconds to force a power down.  Wait 5 
seconds, and then the system may be restarted with another press of this button. 

DO NOT use the rear panel power supply switch to shutdown the Image Server.  Doing so may 
cause loss of unsaved data, and may require the RAID drive array to re-synchronize – a process that 
could take several hours.  Shutdown the system only by momentarily pressing the front panel power 
button, or through the GUI. 

The Quick Restart option in the Start>Shutdown menu allows the GUI and video playback 
application to be restarted without restarting the entire operating system. The Restart FTP Only 
option will restart the FTP service without affecting video operation. 
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On-Screen Main Menu Bar 
Once MAXX has successfully powered up, the VGA monitor will display the GUI of Figure 2. This 
view provides  

• A main System Menu bar for configuration operations  

• A Status Bar that displays various system messages 

• Three VTR-like transport controls, one for each of the three video channels. 

 

 

Figure 2:  Graphic User Interface with Clip Transport Windows  

When using the mouse, all buttons of all channels will operate immediately, without first selecting a 
window to activate it. (Channel 3 is active in the illustration above, indicated by its blue title bar.)  

When using key commands, the active window is the only transport that will respond.  Use the 
CTRL+TAB key combination to change the active window in rotation, or use the mouse to activate 
the desired window by clicking anywhere in it. 

Windows can be moved, resized and overlapped by dragging the title bar, the edges or the resize tab 
at the lower right corner of each window.  The CTRL+TAB key combination will also bring the 
activated window to the top, in front of all other windows. 
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System Menu Bar 
The System Menu bar contains four menus: Show, Edit, Windows and Help. 

Show Menu 
Contains selections for the three Channels and the clip management windows. 

Channel 1   
Channel 2   
Channel 3 

Opens the specified window if it is closed, brings it to the top and activates it. 

Key Commands – F1, F2, F3 

Clip List 

Opens the Clip Navigator window if it is closed, brings it to the top and activates it. See page 52. 

Key Command – Ctrl+L. 

Find Clips 

Opens the Clip Locator dialog. See page 53. 

Key Command – Ctrl+F. 

Edit Menu 
Contains a single selection, Configuration.  This opens the main System Configuration dialog.  See 
page 45. 

Windows Menu 
Choices in this menu change the way the windows are displayed.  Use the CTRL+TAB key 
combination to change the active window in rotation, or use the mouse to activate the desired 
window. 

Cascade 

Arranges all open windows so that they are overlapping, but offset.  It is useful as a starting 
point to rearrange the windows. This choice is especially useful with small monitors. 

Tile 

Arranges all open windows so that each is fully visible at the same time.  This choice is 
especially useful with larger monitors.  In case the Windows don’t tile as expected, select 
Cascade to restore their original size and order, then select Tile. 

In addition, there are selections for each open transport window.  Selecting one of these brings that 
transport to the top of the display and makes it the active window. 
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Help Menu 
Contains a single item, About, which displays the Image Server software versions, serial number and 
Unit ID. 
 

The Status Bar 
A status bar appears at the bottom of the window that provides system information to the user 
including GENLOCK, INPUT VIDEO DETECTED, and TIME REMAINING—PERCENT FULL.  Messages such as 
CONNECTED TO HOST or CONNECTION TO HOST REFUSED are also displayed as diagnostics.  Error and 
status messages from the RAID system can also be displayed here. 
 
 

Channel 1 is the only channel that can either Record or Play video content. Channels 2 and 3 can 
play back content. All channels may be used at the same time.  

 
Each channel can be controlled in two different views. 
 

1. The Transport View 
2. The Playlist View 
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The Transport Channel View 
The Transport Channel View is shown in Figure 3.  This is the default view of each channel. Basic 

transport operations such as play, stop, record, and head/tail trimming appear in the Clip Transport 
window for each channel.  These operate in familiar VTR fashion.  

 

 

Figure 3 - Transport Channel View 

Transport Menu Bar 
There are two menus, File and Options. 

File Menu 
Contains six selections in Channel 1, five in Channels 2 and 3. 

New 

Channel 1 only.  Opens the Clip Navigator to allow naming of a new clip, then prepares the 
channel for recording. See page 38. 

Key Command – Ctrl+N. 

Open 

Opens the Clip Navigator to allow choosing a clip to load into the transport.  

Key Command – Ctrl+D. 



 

Page 32 MAXX Owner’s Manual 

Save 

Saves an edited clip using its existing file name. 

Key Command – Ctrl+S. 

Save As 

Opens the Clip Navigator to allow saving an edited version of the clip with a new name.  This 
allows making alternate versions of a clip or making multiple segments of a master clip. 

Key Command – Ctrl+A. 

Playlist 

Switches from Transport View to Playlist View. 

Close 

Closes the Transport window.  This has the same effect as the Close box in the upper right 
corner of the window.  Note that this will not stop playback or eject a loaded clip. 

 

Options Menu 
This menu contains two selections. 

Take Control 

Takes control of the video channel from another user (the Serial Control, a Remote 
Workstation, or if you are using a Remote Workstation possibly the local GUI.) This item is 
grayed out when the window has control. 

Key Command – Ctrl+T. 

Configure 

Opens the video channel’s Configuration dialog.  See pages 35 and 51. 

Key Command – Ctrl+C. 
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The Playlist Channel View 
The Playlist Channel View is shown in Figure 4. This view allows multiple clips to be loaded 
in a “playlist” and played in sequence. 
 
 

 

Figure 4 - Playlist Channel View 

 

Playlist Menu Bar 
There are two menus, File and Options. 

File Menu 
Open 

Opens the Clip Navigator to allow choosing a clip to load into the transport.  

Key Command – Ctrl+D. 

Append 

Opens the Playlist Selection dialog to allow choosing a Playlist to Append to the 
currently loaded list.  This can be done while playing to allow continuous playback 
of new Playlists.  See page 64. 

Save 

Saves an edited Playlist using its existing file name. 

Key Command – Ctrl+S. 
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Save As 

Opens the Clip Navigator to allow saving an edited version of the clip with a new name.  
This allows making alternate versions of a clip or making multiple segments of a master clip. 

Key Command – Ctrl+A. 

Rename 

Opens the Playlist Selection dialog to allow renaming the currently loaded Playlist. 

Transport 

Switches from Playlist View to Transport View. 

Eject 

Ejects the currently loaded Playlist in preparation for creating a new one.  (It is not necessary 
to Eject a list to load another saved list.) 

Key Command – Ctrl+N. 

Close 

Closes the Playlist window.  This has the same effect as the Close box in the upper right 
corner of the window.  Note that this will not stop playback or eject a loaded list. 
 

Options Menu 
This menu contains two selections: 

Take Control 

Takes control of the video channel from another user (the Serial Control, a Remote 
Workstation, or if you are using a Remote Workstation possibly the local GUI.) This item is 
grayed out when the window has control. 

Key Command – Ctrl+T. 

Configure 

Opens the Playlist’s Configuration dialog.  See page 63.  Note that this is different than the 
dialog for the video channel setup, which must be accessed from the Transport View 
window. 

Key Command – Ctrl+C. 
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MAKING A RECORDING FROM THE GUI 
Video recordings are made using the Transport View of Channel 1.  Channel 1 can record or play 
back clips but cannot do both at the same time. Channels 2 and 3 are playback only. Follow these 
steps to record a clip on Image Server. Note that most of these configuration setting steps can be 
skipped once an established workflow is in place. 

Record Configuration Options 

Set Channel 1 to the Transport View 
If necessary, set channel 1 to the Transport View. Click FILE->TRANSPORT in the Channel 1 
Playlist View to switch to the Transport View. 

Setting the Sync Source 
To use a genlocked source, select External Sync using the GUI as follows: 

A. From the main menu bar select EDIT->CONFIGURE. The screen of Figure 6 appears. 
Select the TIMING option. 

B. Select EXTERNAL as the sync source. 
C. Check that the front panel GENLOCKGENLOCKGENLOCKGENLOCK LED is now illuminated and the word 

GENLOCKED now appears in the bottom right of the main GUI window. 
D. If necessary set the LINES and SUB-PELS settings.  See System Timing on page 68. 

 

About Genlock Signal Quality 

A genlock signal connected to the Image Server must conform to the RS-170A standard. An 
unstable genlock source may result in unwanted artifacts in the video output or recorded data. 

 
To use a non-genlocked CVBS source, follow the instructions above but select either INTERNAL 
or EXTERNAL Sync.  

 

NOTE: The CVBS input of the MAXX is equipped with an Input Frame Buffer that allows recording 
from non-genlocked sources. No configuration is required to use the frame buffer. Refer to Appendix 
D for more information. 
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Figure 5 - Timing Configuration Screen 

Setting the Video Input Source 
The MAXX can accept a video signal at either its composite video input (CVBS), or its serial digital 
(SDI) input.  Verify that the input to be used is currently active.  For a discussion of the SDI – 
Embedded Audio option, refer to Configuring Embedded Audio on Page 69. 
 
Select OPTIONS->CONFIGURE from the Channel 1 Transport Window. 
The Dialog of Figure 6 appears. Select the appropriate Video Input source by clicking the related 
radio button in the Video Input Source section of the dialog. Click APPLY or OK. 
 

 

Figure 6 - Channel Configure Dialog 
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Arming the Audio tracks 
The MAXX can record either two or four audio tracks according to a selection made in the Channel 1 
Configuration window.  When a selection is made it will be saved for future recordings.  

Select OPTIONS->CONFIGURE from the Channel 1 Transport Window. 

Refer again to Figure 5 - Timing Configuration Screen for a view of the Channel 1 Configuration 
Dialog. 

• Check Audio 1-2 if you wish to record on tracks 1 and 2 only 

• Check Audio 3-4 if you wish to record on tracks 3 and 4 (only when using AES-EBU or SDI 
Embedded audio input.) 

• Check BOTH Audio 1-2 AND Audio 3-4 if you wish to record on tracks 1, 2, 3 and 4 

• Uncheck all boxes if you don’t want to record audio. 

• Check Closed Caption for all above cases if you want to record closed caption data into a 
separate, dedicated track (See Setting the Recording Format below). 

Bit-for-Bit® Recording & Playback 

The recording, storage and playback of audio program material such as Dolby®-E, Dolby Digital  
(AC-3) or DTS® requires that upon playout the data stream be identical to the original.  Do not use 
the audio sample rate converters when working with these encoded audio formats.  
The Image Server and a Dolby® encoder must be supplied with the same genlock signal. 

Audio Sync Reference 

The audio sample rate is derived from the selected video sync reference.  Audio is recorded at a 
nominal 48K sample rate, so the 0.1% pull-down for 29.97 NTSC is taken into account when 
generating the audio sample rate for color NTSC.  There is no drop frame in PAL video. 

Setting the Recording Format 
Refer again to Figure 5 - Timing Configuration Screen. 

Select either Main (Main Profile @ Main Level (4:2:0), or 4:2:2 (4:2:2 Profile@ Main Level) by 
selecting the corresponding radio button. Refer to Appendix B for a discussion of Profiles. 

Select either 1:I-Frame Only, 6:IBBPBB or 15:IBBPBB…  
Refer to Appendix B for a discussion of the GOP structure. 

Select the Bit Rate. The range is 4 – 50 Mb/s unless Main profile is selected. In Main profile, the 
maximum rate is 15 Mb/s. Generally, very good quality video can be achieved at rates as low as  
8 Mb/s with IBBPBB settings. 

The Image Server always records Closed Caption data directly into the video.  However, when using 
bit rates below 10 Mb/s it is advisable to enable the dedicated Closed Caption track in the Arm 
Tracks section described above.  This will guarantee that the encoding process will not affect the 
Closed Caption data. 
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Setting the Time Code Source 
This function selects the time code source for newly recorded clips.  A time code value is obtained 
from the selected input source at the start of a new recording.  Refer to Figure 6. Choose VITC, LTC 
or Manual input source.  For MANUAL, enter the desired time value for the first frame of the 
recording in the Starting Time Code entry field. 

Beginning Recording 
When the steps outlined above in “Setting up for Recording” are done, you are ready to record.  
Place Channel 1 in the Record Ready mode as follows.  

A. From the Channel 1 Transport Window, Select FILE>NEW. The dialog of Figure 7 appears. 

 

Figure 7 - Channel 1 Clip Navigator "New" mode 

 
B. Note the Folder Structure in the FOLDERS window to the left. If you have not added any 

folders (Refer to Creating Folders on Page 52) no folders will be shown. If you have already 
created a folder structure you can select the destination folder for your clip at this time by 
clicking on the folder you want it to be placed in. You can always move or copy it later as well. 
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C. Enter a clip name using the keyboard. You may use up to 31 characters.  Spaces may be 
used; however, some characters other than upper or lower case letters and numbers may not 
be used.  These characters will not enter into the name field when typed. They include * ( ) + 
= ; : ‘ “ < > , . / and ?  A list of existing clips will appear in the large window, and can be 
used as a name reference when creating new clip names.  

Note: File naming is case sensitive.  Upper case letters sort before lower case.  The name FILE sorts 
in the order shown, based on differing capitalization:  FILE, File, fiLe, and file.  When using the 
Image Server with automation systems or other remote controls, it is not a good practice to 
distinguish files only by differences in case. 

D. The Channel 1 transport Window will display the words IDLE CUEING for two seconds or 
less. When ready to record, the Channel 1 Transport Window will display IDLE READY. 
 

 

Figure 8 - Channel 1 Ready to Record 

 
E. You may now click the RECORD button at any time to begin recording. The yellow time 

display counters will update the clip duration continually. 

F. To stop recording, click STOP. 

 

Note: An in-progress recording must be at least 10 seconds long before it will appear in the clip list. 
Hitting the STOP button to end the recording after less than 10 seconds will also cause the clip to 
appear in the clip list 
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USING E-E Mode to Monitor the Recording Source 

The E-E button appears in the Channel 1 Record/Play window. It allows the input signal to be 
monitored from the server output.  E-E Mode toggles automatically as described below, but can also 
be switched manually at any time. 

When a new clip is created for recording, the input source is automatically switched ON to the 
output—an E-E connection.  When a clip is opened for play on Channel 1, E-E monitoring is switched 
OFF.   

When Channel 1 is switched to playlist mode, the E-E monitor is switched OFF.  E-E mode cannot be 
toggled while the channel is in playlist mode. 

When E-E is ON, the input video signal is routed to the outputs.  Manually toggle the E-E mode button 
OFF to switch the output to the servers output, for conventional playback operation. 

Under automation control, Auto E-E behavior is slightly different than under GUI control.  The server 
will remain in E-E ON mode until a transport control command (Play, Stop, Jog, etc) is received.  After 
receiving such a command, the server will remain in E-E OFF mode until record mode is entered.  In 
record mode, E-E mode is ON.  As with GUI operation, automation controllers may send E-E ON and 
E-E OFF commands to override the automatic operation. 

Note that when in E-E mode the channel 1 video outputs are not timed to the genlock signal. This will 
not be noticeable when connected directly to a monitor. However, there will be timing offsets when 
feeding timed routers or switchers.  The symptoms of this will vary depending on the particular 
equipment, including horizontal picture shift or timing error indications.  . If the input is not 
synchronous with genlock, it may roll vertically.  E-E mode is not intended to be used on-air, only as a 
production tool. 
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PLAYING A CLIP FROM THE GUI 
Video Playback can be done on all three channels, individually or simultaneously. Channel 1 

cannot Record and Playback at the same time.  Follow these steps to play back a clip.  

Beginning Playback 
 

A. Select FILE>OPEN from the Transport Window of Channel 1, 2 or 3. The Clip Navigator will 
appear per Figure 9. 

B. Navigate the folder structure if necessary by clicking on the folders. 
C. Select the clip you want to play by double-clicking on it. 
D. When the Transport Window indicates Idle Ready, you can play the clip at any time by 

clicking PLAY. 
 

 

Figure 9 - Channel 1 Clip Navigator in “Open” Mode 

Looping a Clip 
Clicking on the LOOP checkbox in the Transport View will cause a clip to loop until LOOP is 
unchecked or until you click STOP. LOOP may be checked or unchecked before or during 
playback, but must be changed at least 2 seconds before the end of clip to take immediate effect. 
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Pausing a Clip 

Click PAUSE at any time to pause a clip. Click again to resume. The PAUSE button is the 
same key as the PLAY button. 

Ejecting a Clip 
Ejecting a clip effectively removes it from the transport. The channel will output Black. Press EJECT 
to eject a clip.  

Using Jog 
The JOG + command will move to the next frame and go to Still.  The JOG - command will move 
to the previous frame and go to Still. 

Using GO-TO 

Click the arrows |< or >| to go to the next trim point (Mark In or Mark Out) in the selected direction.  
When in Edit mode, an additional click in the selected direction will go to the actual beginning or end 
of the entire clip. 

Using Fast Forward / Rewind  
F-F (Fast Forward) and REW (Rewind) buttons transport program material at high speed in the chosen 
direction.  Four speed choices are available in each direction. Click the button repeatedly for: 4x, 16x, 
64x, and 128x.  Audio does not play at these speeds. 

Using Shuttle to Control Playback Speed 
The Shuttle Control is a slider bar that controls playback speed. Playback speed control employs 
varispeed algorithms that may skip frames. It is not a perfect fast motion mechanism. 

The center position represents zero speed, or Still.   

The right and left extents of the slider represent ±2x maximums.   

The Shuttle control slider works in three basic ways: Snap-Back to still, Hold Speed, and Mouse 
Wheel. 

• In Snap-Back operation, click and drag the slide control to change speed.  Releasing the slider bar 
will let it snap back to zero speed, or still. 

• For Hold Speed operation, position the cursor over the slider control scale (not the slider arrow) 
and click the left mouse button to increment the speed control.  The transport will run in the 
selected direction at the selected speed without holding the mouse button down.  The cursor 
may now be moved over the Stop button to wait for the desired point. 

• When using a scroll mouse, position the cursor over the slider scale and rotate the wheel to 
increment speed.  Rolling the wheel in opposite directions changes the direction the arrow slider 
moves.  To stop video, click the Stop button or the arrow slider. 
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EDITING A CLIP 
Edit controls are activated with the Edit check box.  Several buttons are available to define the 

beginning and end of a region within a clip; associated time code displays are also present. 

These non-destructive Mark In and Mark Out trim points can be set to define a portion of a clip to 
be played.  These “edit pointers” do not create a new clip from the original material; they act like 
virtual trims, and material outside of the trim points is excluded, but can be retrieved by resetting the 
Mark pointers.  After setting the Mark In and Mark Out points, clips will play between these points.  
These edit values are saved with the clip. 

Edits may be saved to the current clip by de-selecting the Edit check box, or choosing Save from 
the clip window File menu.  Save As works to save the edit points to a new clip name, even if the 
edits have not been saved in the current clip.  This is a great help while conducting an Edit-while-
Recording. 

Using Edit-while-Recording 
Clips are most often edited after recording is complete, but it is sometimes desirable to create sub-
clips while the recording is still in progress.  This is the preferred way to extract sports highlights, for 
example. 

First, wait at least ten seconds after the recording begins. Open the recording on either Channel 2 or 

3 by selecting the clip name from the FILE>OPEN menu. (A recording must be 10 seconds long 
before it will appear in the clip list.) 

Use the transport controls to select and mark the In- and Out-Points, as desired. 

Without un-checking Edit, select FILE>SAVE AS, enter a new clip name, and click Enter.  A new 
clip is created that will play only between the In-Point and Out-Point.  This clip can now be played 
on the third channel, or assembled into a playlist. 

Next, use the transport controls to locate another set of In- and Out-Points for a second segment, and 
repeat the Save As command. 

As noted above, it is usually easier to leave the edit channel in Edit mode when you plan to make 
multiple “Saved As” clips.  If you de-select Edit with unsaved changes, you will be given a choice to 
save or discard the edit points.  Remember that you will be saving the edits to the file that is 
currently being recorded. Re-editing is required to see parts of it outside the region defined by  
Mark In and Mark Out, even if the recording continues after the editing session. 

Marking the IN point  

Sets the current time code value into the Mark In point time display.  The Mark In button can capture 
a time code value from the clip when it is still, or on-the-fly.  

Mark In Display 

Displays the time code of the Mark In point.  When no Mark In point has been set manually, this 
displays the Start of Message (SOM) time code (usually 00:00:00:00).  Trim points will be 
automatically rounded down to the nearest GOP boundary when edits are saved. 
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The values in this display window may be set by two methods: 

•  Enter Mark In point from the keyboard:  Use the mouse or Tab key to move between In 
and Out fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Whether a clip is still or playing, press Mark In to capture a time code value from the clip’s 
current position. 

Marking the Out Point 

Sets the current time code value into the Mark Out point time display.  The Mark Out button can 
capture a time code value from the clip when it is still, or on-the-fly. 

Mark Out Display 

Displays the Mark Out point time code.  When no Mark Out point has been set manually, this 
displays the EOM time code (originally the end time of the recording). 

The values in this display window may be set by two methods: 

• Enter Mark Out point from the keyboard:  Use the mouse or Tab key to move between In 
and Out fields.  When a field is highlighted, enter a numeric value from the keyboard. 

• Whether a clip is still or playing, press Mark Out to capture a time code value from the 
clip’s current position. 

Duration Display 

Displays the total running time (TRT) of the current clip.  TRT is defined as the difference in the time 
codes between the first and last frames, plus one. For example, if the first frame of the clip is 
00:00:00:00 and last frame displayed at the end is 00:00:01:15, the reported duration will be 
00:00:01:16.   

With NTSC drop-frame time code, the true play duration may not be the exact numerical value of 
((Mark Out – Mark In) + 1) due to the discontinuities in the drop-frame time line. The true run time is 
shown in the Clip Navigator. 

 Auditioning the Mark In Point (Review Clip Button)  

The Review Clip button   |<–>|   cues the clip to the Mark In point (or SOM, if no Mark In point 
exists) and begins playback.  Review Clip will stop at the Mark Out point.  The Mark Out point will be 
displayed in Still mode. 

The Review Clip button may be used to check the Mark In point without playing all the way through 
the clip.  After Review Clip is pressed and play begins, all of the standard transport buttons are 
available for use. 

Auditioning the Mark Out Point (Review Out Button) 

The Review Out button     –>|      may be used to audition the Mark Out point without playing all 
the way through the clip.  It will cue the clip to three seconds before the Mark Out point (or EOM, if 
no Mark Out Point exists) and then begin playback.  Review Out will stop at the Mark Out Point. 
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SYSTEM CONFIGURATION 
The following configuration options apply to the System as a whole and not to individual channel 
transports. 

Assigning Names to the Server and Transport Channels 
The Image Server can be assigned a name that will be displayed along the top of the Main 
GUI Window. Each individual channel transport can also be given a name.  
To assign a name to the server or transport channels, click EDIT>CONFIGURE>NAMES 
from the main menu pulldown.  
 
The screen of Figure 10 is displayed. Use the keyboard to type in a name for any of the 
selections. Names can be up to 31 characters in length. Spaces, digits and other non-
alphanumeric characters may be used. Click APPLY to accept the name. The names will 
appear in their appropriate windows immediately. 
 

 

Figure 10 - Configure Names Screen 
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Programming GPIO Outputs 

The MAXX has six General Purpose Outputs, referred to as GPO 1 through GPO 6.  Each GPO can 
be programmed to go active on the selected channel when one of the following events occurs. 

IDLE    - Activate when the transport returns to idle 

PAUSED    - Activate when the transport is paused 

STOPPED  - Activate when the transport is stopped 

PLAYING  - Activate when the transport is playing 

RECORDING  - Activate when the transport is recording 

RAID System Fault  - Activate when a RAID or System Fault occurs 

NO GENLOCK  - Activate when there is no genlock 

NO VIDEO INPUT - Activate when there is no video at the selected input 

PLAYLIST   - Control GPO via playlist. (Refer to page 66.) 

To program a GPIO output, select EDIT->CONFIGURE->GPO. The screen of Figure 11 is 
displayed. GPO 1 through 6 are the 6 triggerable outputs. The checkboxes to the right of each 
selection represent channel 1, 2 and 3. GPO 5 is shown with the trigger option pulldown expanded. 

To activate one of the GPO, pulldown the event menu and select which event will activate the GPO. 
Select an associated channel where applicable by checking the channel checkbox. Click APPLY to 
activate. 

 

Figure 11 - GPO Configuration Screen 
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Programming GPIO Inputs 

The MAXX has six General Purpose Inputs, referred to as GPI 1 through GPI 6.  Each GPI can be 
programmed to trigger one of the following events on a channel. 

CUE   Cue a clip 

JUMP   Cue selected clip for immediate playback   (Playlist Mode only) 

NEXT   Prepare next clip in a playlist for playback (Playlist Mode only) 

PAUSE   Pause a clip 

PLAY   Play a clip 

RECORD   Start a recording 

SELPREV   In Playlist Mode – Navigate to clip above currently selected clip 

SELNEXT   In Playlist Mode – Navigate to clip below currently selected clip 

STOP   Stop a clip    

To program a GPIO Input, select EDIT->CONFIGURE->GPI. The screen of Figure 12 is displayed. 
GPI 1 through 6 are the 6 programmable inputs. The checkboxes to the right of each selection 
represent channel 1, 2 and 3. GPI 5 is shown with the trigger option pulldown expanded. 

To activate one of the GPI, check the checkbox for the channels of interest, then pulldown the event 
menu and select which event will be triggered when the GPI goes active. Click APPLY to activate. 

 

Figure 12 - GPI Configuration Screen 
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Configuring Linear Time Code (LTC)  
The Image Server supports only drop-frame time code for NTSC operations. It may not be used with 
non-drop-frame time code. LTC Out Source chooses which channel will control the LTC Timecode 
output. 

Configuring the Network 
The Image Server provides a number of user settings that configure it for use as a practical network.  

These will be found on the Configure Network tab shown below. 

 

The NETNETNETNET----1111 Ethernet port on the Image Server has a unique IP Address.  In this way, each Image 
Server can be identified on the network.   

Network Settings Tab 

Use the Image Server graphic user interface to configure network communication settings. From 
the Main Menu selection bar at the top of the screen. 

Click EDIT>CONFIGURE->NETWORK 

The screen of Figure 13 is displayed. 

 

 

Figure 13 - Network Configuration Screen 
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Each Image Server is shipped with a default network Host Name and IP Address.  Qualified 
network engineers may change these configurations to suit your specific network environment.  
Factory defaults for networking are: 

• Network Disabled 

• Use DHCP 

Disabling the Network [X] 

This selection turns the network OFF or ON.  The default is ON, but can be turned off to deny 
access to/from the network for security purposes. 

Enabling/Disabling DHCP [X] 

Enabling DHCP will configure the network interface automatically. 

If the DHCP box is not selected, the user may then manually enter assignments in the 
following windows: 

• IP Address   ( Example: 192.168.1.20 ) 

• Net Mask  ( Example: 255.255.255.0 ) 

• Default Router  ( Example: 192.168.1.1 ) 

 

The Host Name and NTP domain name may be a fully qualified domain name, such as 
edit1.mydomain.com.  All other manually configured addresses must be properly formatted IP 
addresses. 

Saving Network Configuration 

Click on OK, APPLY, or CANCEL to accept or abandon new entries.  
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Setting the Date and Time 
 

Click EDIT->CONFIGURE->DATE/TIME. The dialog below appears. 
 

 

 

Figure 14 - Time/Date Configuration Screen 

 
Select the REGION and ZONE according to your geographical location and time zone by 
scrolling with the scroll-bar as necessary and then clicking on the selected value. 
 
Set the TIME and DATE by clicking on the Time/Date field and navigating the clock and 
calendar. 
 
Check Automatic Updates to enable automatic updates using the Network Time Protocol  
(NTP). Refer to Network Time Protocol on page 78. 
 

 
           Note: A System Restart is required for a Time Zone change to take effect 
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Calibrating Channels 

Setting the SC/H Phase 

Refer to Figure 15. This parameter adjusts the Sub-Carrier/Horizontal phase relationship.  Use a vector 
scope to view the phase relationship and adjust the setting.  Changes to the setting are effective 
immediately without clicking Apply or OK.  The adjustment range is ±90°. 

Setting the Audio Delay 

Refer to Figure 15. Audio timing relative to picture output can be configured for audio channels 1-2 
and 3-4.  The value is set in millisecond increments, plus-or-minus 1,000ms (up to 1 second).  The 
setting is applied to a clip when it is loaded for playback. This can compensate for systems issues 
downstream from the server that result in leading or lagging audio. 

 

 

Figure 15 - Playback Channel Configuration 
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CLIP NAVIGATOR 

MAXX provides a powerful Clip Navigator for finding and selecting clips. Clip Navigator allows the 
user to delete, name and rename clips. 

• Rename and Delete Clips 
• Create, name and rename “folders”. 
• “Nest” folders within other folders. 
• Freely Move, Copy and Rename clips within the folder structure. 
• Find Clips within the folder structure. 
• Clips can be dragged and dropped anywhere on a Transport for immediate playback. 
• Selected single or multiple clips can be dragged into a Playlist.  See page 59. 

Creating Folders 
To create a folder: 

A. Click SHOW->CLIPLIST from the main pulldown menu. 
B.  The Clip Navigator of Error! Reference source not found. is displayed. Right-Click 

on the folder icon displayed under the FOLDERS window.  
C. Select NEW FOLDER from the pulldown. Enter the folder name in folder name dialog 
D. Click OK.  
E. A “nested” structure can be created by repeating the procedure with an existing 

folder selected. The new folder will be created “under” the selected folder. 

 

Figure 16 – Clip Navigator 
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Renaming and Deleting Folders  
To Rename a folder, right click on the folder and select Rename Folder from the popup menu. 
Note that renaming a folder should be avoided when it contains clips included in playlists.  The path 
names in the playlist will not be updated and the clips in the renamed folder will be listed as 
“MISSING” when the playlist is loaded. 

To Delete a folder, first delete or move all of the clips and subfolders it contains. Then, right click on 
the folder and select Delete Folder from the popup menu. 

Navigating Folders 
Once a folder structure is created, it can be easily navigated with the Clip Navigator. Move from 
folder to folder simply by clicking on the folders in the FOLDER window. The view will 
automatically expand if folders are “nested” within folders. Figure 17 shows a 3 level nested folder 
structure. 

 

Figure 17 - Clip Navigator with folders 

Moving and Copying Clips 
Clips can be moved and copied from any folder to any other folder. Note that moving a clip that is 
included in a playlist will make it unavailable in that playlist.  Also, if an automation system is in use, 
moving a clip out of the folder assigned to the serial port will make it unavailable to the automation 
system. 
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To move a clip to another folder: 

 
A. Expand the folders in the FOLDER window so that the destination folder is visible. 
B. If necessary, you can limit the number of clips displayed by typing a string in the 

FILTER window. For example, typing “AT” in the filter window would limit the 
display to all clips that contain “AT” somewhere in the clip name. Pressing the 
Clear button restores the complete display. 

C. Navigate to the clip location. 
D. Drag the clip to the destination folder by placing the cursor over the clip, holding 

down the left mouse button and “dragging” it to the destination folder. Release 
the left mouse button to “drop” the clip into the destination folder. 

E. MAXX 6T will list two options. MOVE HERE or COPY HERE. Select MOVE HERE 
to delete the clip from the original directory. Select COPY HERE to leave the 
original copy intact. .  Note that this is a “virtual” copy, both clip names refer to 
the same data on the disk. 

 

Renaming and Deleting Clips 
Clips can be renamed by right clicking on them with the mouse, then selecting Rename from the 
pop-up menu.   

Clips can be deleted by right clicking on them with the mouse, then selecting Delete from the pop-
up menu. 

Sorting Clips 
Clips can be sorted in forward or reverse order by any of the columns by clicking once or twice on 
the column heading.  The previous sort is maintained so for instance if you sort by Name then by 
Profile, the clips of each Profile will be sorted by Name.   

Filtering the Clip Display 

You can limit the number of clips displayed by typing a string in the FILTER field. For example, 
typing “AT” in the filter field would limit the display to all clips that contain “AT” somewhere in the 
clip name. Pressing the Clear button restores the complete display. 

Finding Clips 
Clips can be easily found using the Clip Locator. To locate a clip: 

A. Click SHOW>FIND CLIPS. The Clip Locator screen of Figure 18 appears. 
B. Select a “root” folder to begin a search by selecting the folder from LOOK IN. 
C. Check Search Subfolders to search in folders “under” the selected folder. 
D. Check Case Sensitive to make the search case-sensitive. 
E. Check Stop After First Match to find only the first match. 
F. Check Use Regular Expressions to search for the string of interest ANYWHERE in the clip 

name. With Regular Expressions unchecked, the search will match only clips that BEGIN 
with the string entered at FIND. 
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G. Optionally, Enter a string in the FILTER field to limit the number of clip displayed. For 
example, entering “AT” in the FILTER field will limit the display to only clips containing “AT” 
in their clip name. Pressing the Clear button restores the complete display. 

H. Enter a name or part of a name in the FIND field. Press ENTER to initiate the search. The 
clip(s) will be displayed according to the rules set by the checkbox settings. 

 

 

Figure 18 - Clip Locator 
 

Finding Clips Using Wildcards 
The following wildcard conventions may be used in a search. 

* Match anything.  For example, to find all clips starting with “xyz”, use the pattern “xyz*”.  To 
find all clips containing “2008” use “*2008*”. 

? Match any single character. 
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Finding Clips Using Regular Expressions 
A regular expression (or RE) specifies a pattern to be matched in a clip name. 
Regular expressions can contain both special and ordinary characters.  Ordinary characters just 
match themselves.  Thus, the RE “night” would match the “night” in the clip name “Tonight Show”, 
so this and any other clip name with “night” in it would be placed in the list of found clips. 
 
The following special characters are supported:  
.  (dot)  This matches any single character.  “a.c” matches “abc”, “aac”, “a2c” and “a c” but 

not “acd”. 

^ (caret) This matches the start of a clip name.  To find all clips starting with “xyz”, for 
example, use the Regular Expression “^xyz”. 

$ Match the end of the clip name.  To find all clips ending in “xyz” use the RE “xyz$”. 

< Match the beginning of a word.  For example “<Show” will match all clip names 
containing a word that starts with “Show”, such as “Now Showing”, but not “LateShow”. 

> Match the end of a word. 

* Match zero or more repetitions of the preceding character. G*N “.*” will match anything – 
“G.*N.*” will match “Georgia Evening News” or “Good Night” 

+  Match 1 or more repetitions of the preceding RE. 

? The preceding Regular Expression term is optional. “ab?c” will match “ac” or “abc” but not 
“adc”. 

[ ]  Used to indicate a set of characters. Characters can be listed individually, or a range of 
characters can be indicated by giving two characters and separating them by a "-". Special 
characters are not active inside sets. For example, [a+$] will match any of the characters 
"a", "+", or "$"; [a-z] will match any lowercase letter, and [a-zA-Z0-9] matches any letter or 
digit.  If you want to include a "-" inside a set, precede it with a backslash, or place it as the 
first character. You can match all characters that are not within the set by making "^" as the 
first character of the set; "^" elsewhere will simply match the "^" character. For example, 
[^7] will match any character except "7".  

SPACE A space is treated as an ordinary character.  “ Show “ (<space>Show) will match “Tonight 
Show” but not “Now Showing” or "NewShow”. “ “ will match any clip with a space in the 
name. 

The subject of Regular Expressions is much larger than can be completely covered here.  They are 
used in several different operating systems and programming languages.  Further information can be 
found on the internet and in books on Regular Expressions and Linux. 
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USING PLAYLISTS 
MAXX’s Playlisting software provides an extensive set of capabilities for building, editing and playing 
complex sequences of program content.  Advanced Playlisting appears as on-screen windows, with a 
clean Graphic User Interface that makes it easy to run with no extra equipment.  It’s invaluable for 
building commercial breaks, news rundowns, still-store and clip lists.  You can create and store as 
many playlists as needed, each with its own unique name.  For many users, Advanced Playlisting 
may be all that’s needed to go to air. The Playlisting software has the following features and benefits. 
 

• Drag-and-drop playlist building and editing on a graphic interface 

• Edit lists while they’re running 

• Start at any point in a list 

• Displays run time for clips, plus segment length and total remaining time 

• On-the-Fly commands for Pause, Skip, Hold, Next and Jump functions 

• Append a playing list with a saved playlist 

• Six programmable GPI Output events embedded in playlist clips 

• Programmable time-of-day start for a playlist 

• Generates an As-Run Log 

• Set rules for deleting unneeded material on the playlist 

• Simple text format allows playlists to be created, viewed and edited offline 

• FTP access allows playlists to be transferred between Image Servers or to/from a PC 
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The Playlist view 
The Playlist View for channel 1 is shown in Figure 19. Its functions are briefly described 
here. Table 1 provides an overview of Playlist control functions and their associated hot-
keys. 

 

 
 

Figure 19 - Channel 1 Playlist View 

 
FUNCTION DESCRIPTION / REFERENCE INVOKE HOT-KEY 
PLAY/ PAUSE Play / Pause a clip ( Page 41, 61 ) PLAY Button P or SPACE 

STOP/ SHOW Stop / Show First Frame  ( Page 61 ) STOP Button S 

CUE Cue a clip ( Page 61 ) CUE Button C 

NEXT Prepare next clip for playback ( Page 62 ) NEXT Button N 

JUMP Jump to the selected clip ( Page 62 ) JUMP Button J 

LOOP Check to loop a Playlist ( Page 61 ) LOOP 
Checkbox 

L 

EDIT Check to enable editing ( Page 64 ) EDIT 
Checkbox 

E 

ARM START TIME Enable Scheduled Start Time  ( Page 61 ) ARM START 
TIME 

Checkbox 

T 

HOME Scroll to currently playing Clip ( Page 62 ) HOME 
Button 

H 

Table 1 - Playlist Control Functions 
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Creating and Running a Playlist 

To Create a Playlist (Using channel 1 in the example): 

A. Change the transport for Channel 1 to the Playlist View. Click FILE->PLAYLIST in 
the Channel 1 transport pulldown menu. The window of Figure 20 appears.  

B. Click the EDIT check box to put the channel into edit mode. 

C. Click SHOW->CLIP LIST from the main menu to open the Clip Navigator. Both 
windows are now visible.  

D. Double click on a clip in the Clip Navigator to add it to the Playlist. The clip will appear 
in the playlist. The first clip will indicate a status of CUED.  Alternately, click on any clip 
and hold the mouse button as you move the cursor to the playlist.  Let go of the button 
when the cursor is over the position that you want the clip to appear in the playlist (drag 
and drop). 

E. Repeat the procedure to add more clips. 

 

Figure 20 - Channel 1 playlist with Clip Navigator 
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F. Click PLAY to run the playlist. The clips will be played in the order they were entered in 
the playlist. The currently playing clip will indicate a status of PLAYING. The next clip on 
the list will indicate a status of CUED 

 

Figure 21 – Active Playlist 

G. To SAVE the Playlist select FILE->SAVE-AS. Enter a file name. Click SAVE. 

H. To SAVE an existing playlist without changing the name, use FILE->SAVE. 
 

Status Indications 
Status refers to what has taken place, is now taking place, or will take place with regard to each clip. 
 

BLANK WHITE CLIP IS AVAILABLE TO PLAY 

CUEING PURPLE CLIP IS TRANSITIONING TO A CUED STATUS. MAX TRANSITION TIME IS 4 SEC. 

CUED YELLOW CLIP IS READY TO PLAY ON COMPLETION OF THE PRECEDING CLIP, OR WHEN THE 

PLAYLIST STARTS, IF NOT PRESENTLY RUNNING. 

PLAYING GREEN CLIP IS ACTUALLY PLAYING. 

DONE GRAY CLIP HAS PLAYED COMPLETELY, FROM FIRST FRAME TO LAST FRAME. 

MISSING RED CLIP WAS NOT FOUND 

CLIPPED GRAY CLIP BEGAN PLAYING, BUT DID NOT COMPLETE 

PAUSED GREEN CLIP HAS BEEN PAUSED. FURTHER, WHEN PAUSE IS ASSERTED THE PLAYLIST IS 
NOT ADVANCING. 

SKIPPED GRAY CLIP WAS SKIPPED, EITHER BY A NEXT OR CUE OPERATION, OR BECAUSE THE 
SKIP CHECKBOX WAS SELECTED. 
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Loading a Playlist (FILE>LOAD) 
Click FILE->LOAD from the Playlist View to bring up the list of available PlayLists. Double-click on 
a playlist to load it. 
 

Saving a new Playlist (FILE>SAVE AS) 
Once a Playlist has been created, it can be saved by selecting FILE->SAVE AS from the Playlist View 
pulldown menu. Type in an appropriate name and click SAVE. 

Saving an existing Playlist (FILE>SAVE) 
An existing Playlist can be saved by selecting FILE->SAVE from the Playlist View pulldown menu. 
Type in an appropriate name and click SAVE. 

Setting a Start Time for a Playlist) 
Set a start time for a Playlist by entering a twenty four hour time of day in Hours, Minutes and 
Seconds in the START TIME field (see Figure 19 ). Click on any field to edit the field. Check the ARM 
START TIME checkbox to arm the start time. The ARM START TIME checkbox will automatically 
uncheck itself once the playlist has started 

Stopping a Playlist (STOP) 
Click STOP to halt a Playlist. 

Pausing a Playlist (PLAY/PAUSE) 
When a Playlist is running, the PLAY key will change to indicate PAUSE. Pressing PAUSE stops the 
Playlist immediately, on the current frame of a clip. Pressing it again will resume playback. 

Cueing a Clip (CUE)  
When the Playlist is running, click CUE to immediately prepare a selected clip for playback. 
When the current clip is finished playing, the Playlist will play the Cued clip, followed by all 
subsequent clips.  This allows the user to skip over clips that appear in the list between the currently 
playing clip and the selected clip.   

The user may also re-cue a clip that has already been played.  In this case, the Playlist will restart 
from the selected clip, and all subsequent events will be played (or re-played) in sequence.  When 
the Playlist is stopped, CUE will prepare the selected clip to play when Play is pressed, or the list is 
started automatically by Arm Start Time. 

Looping a Playlist (LOOP  [X] ) 
To loop the entire playlist after the last clip completes, check the LOOP checkbox at any time. Upon 
un-checking, the list will play to completion and then stop. 

Showing the First Frame of a CUED clip (SHOW) 
When a clip is cued, the STOP button legend changes to SHOW.  Pressing it will display the first 
frame of the cued clip. 
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Preparing the Next Clip for Playback (NEXT) 
When a Playlist is stopped, click NEXT to prepare the next clip in the Playlist for playback.  While 
the Playlist is running, NEXT will immediately begin playing the next clip in the Playlist. (The next 
clip may require several seconds to load and cue for a seamless transition.)   If the next event in the 
Playlist is a HOLD, the NEXT command will move to the Hold event, and video will display black. 

Jumping to a selected Clip (JUMP) 
Click JUMP to cue any selected clip for immediate playback; this permits jumping over intervening 
clips.  JUMP also allows clips that have already been played to be immediately re-cued and played.  
In this case, the Playlist will restart from the selected clip, and subsequent events will be re-played in 
sequence. 

Automatically scrolling to the currently playing Clip (HOME) 
Click HOME to make the currently playing clip visible in the List View window. .  If no clip is 
playing, then the currently-cued clip is displayed. This is helpful if you have manually scrolled 
elsewhere in large Playlist. Once this is done, the display will also maintain the currently-playing clip 
within the window, if EDIT is off 
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Setting the Maximum Number of Played Items to Keep 
To set the number of played items to be retained in a playlist: 
Click OPTIONS>CONFIGURE from the Playlist View of the channel pulldown. Use the 
thumbwheel UP and DOWN scroll button to increase or decrease the number of clips to 
retain. The default value of zero will retain ALL Clips. 
 

 

Figure 22 - Channel Playlist Configure Screen 

Enabling As-Run Logging 
To enable As-Run logs, Click OPTIONS>CONFIGURE from the Playlist View of the Channel 
Transport. Check the Enable As-Run logging to enable As-Run logging. Uncheck the box to 
disable As-Run logging.  When enabled, a check mark will appear next to the As-Run log label, 
and files played by a playlist will be written to an As-Run log. As-Run logs are available only 
through FTP downloads; they cannot be viewed or printed from the Image Server.  After logging 
into an Image Server, select the ASRUN folder.  All logs are stored in this location, and have the 
extension “.arl”. Refer to APPENDIX E – AS-RUN LOGGING for more details about As-Run 
logging functionality. 

Viewing, Editing and Archiving Playlists 
Playlists can be accessed via the MAXX’s FTP feature, allowing several capabilities: 

• Lists can be backed up on a PC, and sent to another Image Server. 
• Lists can be viewed and printed from the PC 

• Lists can be edited or created on the PC and uploaded to the Image Server. 

Playlists are found on the MAXX FTP directory in the lists folder.  They are simple text files with 
the extension .lst. Refer to APPENDIX D – PLAYLIST MANAGEMENT DETAIL for more 
information. 
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EDITING PLAYLISTS 

Removing a Clip from a Playlist 
To remove a Clip from a Playlist: 

A. Make sure the clip to be removed is not PLAYING or CUED 
B. Position the cursor over the Clip and right-click. Select REMOVE from the pulldown menu. 

Removing All Clips Above or Below the Selected Clip 
All clips above or below the selected clip can be removed unless a CUED or PLAYING clip is 
affected. These options will “grey out” if removal is not allowed for this reason. 

 
To Remove All clips above a selected clip: 

A. Move the cursor over the clip to select it 
B. Right click the mouse and select Remove All Above from the pulldown menu. 
 

To Remove All clips below a selected clip: 
A. Move the cursor over the clip to select it 
B. Right click the mouse and select Remove All Below from the pulldown menu. 

Inserting a HOLD into a Playlist 
The HOLD command inserts a hold (wait) event in a Playlist immediately before the selected clip.  
The PLAY or JUMP command will restart a Playlist after it has stopped on a HOLD line.  The HOLD 
command is also available in the Playlist Item Context Menu, accessed by right-clicking in the 
Playlist item window.  If a Programmed Start Time has been set and is armed, the Playlist will resume 
when the Programmed Start Time occurs. See Page 61 for instructions on setting a programmed start 
time. 

Appending a Playlist (FILE->APPEND) 
Make sure the EDIT checkbox is checked in the Playlist View window.   
Click FILE->APPEND from the Playlist View to bring up the list of available PlayLists. Double-click 
on a playlist to load it.  It will appear at the end of the list after a label event that shows the name of 
the appended list.  This operation can be performed during playback, allowing a new playlist to be 
loaded without interruption of programming. 
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Changing the duration of Clips in a Playlist 
Make sure the EDIT checkbox is checked in the Playlist View window. Position the cursor over a clip 
and right-click. Select EDIT DURATION from the pulldown menu. Enter a duration in the Duration 
window. The minimum duration is 4 seconds. The entry may be in one of these formats. 

1. Hours, Minutes, Seconds and Frames entered as HHMMSSFF  
04300102 = 4 Hours, 30 minutes, 1 second, 2 frames  

2. Hours, Minutes, Seconds and Frames entered as  HH:MM:SS:FF   
03:39:41:17 = 3 Hours, 39 minutes, 41 seconds, 17 frames  

3. As a whole number along with the special characters H for hours, S for seconds, M for minutes  
7H would set 7 hour duration. 31m would set 31 minutes. 15s would set 15 seconds. 

 

NOTE: The Clip duration is affected only within the Playlist, for this event. The duration of the 
source clip is not changed.  Other events containing the same clip are not changed. 
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Mapping GPO to Playlist events 

The Image Server has six General Purpose Outputs, referred to as GPO 1 through GPO 6.  Any of 
these can be programmed to go active at a pre-determined time, or offset, after the beginning of a 
Playlist clip.  An active duration can also be set, after which the output again goes inactive.  In all 
cases, every output will go inactive when a clip ends.  By default, a new clip contains no 
programmed GPI output commands. Refer to APPENDIX F – GPIO SPECIFICATIONS for details on 
electrically interfacing to the GPO lines. 

To Map a Playlist event to a GPO Line, Follow these steps. 

A. Select EDIT>CONFIGURE->GPO. The screen of Figure 11 is displayed. GPO 1 
through 6 are the 6 triggerable outputs. The checkboxes to the right of each selection 
represent channel 1, 2 and 3. GPO 5 is shown with the trigger option pulldown 
expanded.  

a. Set the GPO of interest to PLAYLIST mode from the pulldown  

b. Set the Channel to video 1, 2 and/or 3 by checking the appropriate box to the right. 
Click APPLY to activate the settings.  

B. Check the EDIT checkbox in the Playlist View of the transport. 

C. Place the cursor over a Clip in a Playlist. Right click on the clip. Select EDIT GPO. The 
GPO Editor (Figure 24 ) appears. 

D. Enable the GPO of interest by checking the corresponding ENABLED checkbox. 

E. Enter an offset into the Clip to activate the GPO line in the Offset Field. The form of the 
field is Hours, Minutes, Seconds and frames. ( HH:MM:SS:FF ) 

F. Enter the Duration for the GPO to remain active in the Duration Field using the same 
format. Click  APPLY to activate the changes. 

 

Figure 23 - GPO Configuration Screen 
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Figure 24 - GPO Editor 

 

Mapping GPI to Control a Playlist 
Playlists can be controlled with the Six GPI Inputs as described in Programming GPIO Inputs 
on page 47. 
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Advanced Topics 

System Timing 
The Image Server is capable of using an external genlock signal as a timing reference.  This allows 

the outputs to be timed the same as other video signals in a facility.  There are three adjustments to 
fine tune this synchronization to compensate for differences in equipment and wiring. Genlock 
LINES and SUBPELS set the sync relationship of all of the outputs to the incoming reference.  Color 
timing is adjustable for each channel independently with the SC/H PHASE setting. 

These settings should be made in the following order: 

1. Genlock Lines: This is a global setting for all of the outputs. It rarely ever needs to be 
adjusted. It allows the output timing to be varied by a line of video.  This would be 
adjusted so that the output of the first line of video happens concurrently with other 
contributing inputs.  The visible effect is that the picture will rise or fall by one line when 
viewed at the output of a video switcher or on a genlocked monitor.  Note that this setting 
can cause vbi lines such as Closed Captioning and VITC to appear on different (and 
possibly inappropriate) lines. 

2. Genlock Subpels: This is a global setting for all outputs. It allows the output timing to be 
adjusted by half a pixel.  The visible effect is that the picture will move horizontally when 
viewed at the output of a video switcher or genlocked monitor.  The adjustment is made 
by using a waveform monitor and comparing the falling edge of horizontal sync between 
the output and another contributing signal (not the genlock signal.)  Some video switchers 
indicate when a signal is timed within spec; this can be used to determine when the 
setting is correct. If correct system timing is indicated over a range of subpel settings, 
determine the extreme of the range and set the value in the middle. 

3. SC/H Phase: This is a setting per channel, found in the Transport>Options>Configure 
menu (it does not appear in the Playlist’s Options menu.)  The adjustment is made by 
using a vector scope display referenced to the color reference, usually the genlock signal.  
Play back the zCBARS clip. Adjust the SC/H PHASE to align the color with the vector 
scope points.  Note that it is normal to see some slight periodic variation in the vector 
display. 
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Using Embedded Audio 
Embedded Audio is standard equipment on MAXX.  It is based on SMPTE standard 272M-A.  Key 
features include: 
• Synchronous 20-bit audio at a 48K sample rate.  Non-synchronous audio and other sampling 

rates are not supported.  

• While up to 16 channels of audio may be present in an SDI stream (arranged in 4 groups of 4 
channels), the Image Server records and plays back only Group 1 audio channels (channels 1-4).  

• In E-E mode, all embedded audio will pass through the Image Server unaltered.  

• The user can select audio to record from either a +4 analog, AES/EBU digital, or embedded 
audio source.  Mix-and-match among inputs is not supported. 

• Embedded audio is always included in the SDI stream on playback, and audio will 
simultaneously appear on the AES/EBU or analog audio outputs, as selected by the audio card 
option jumpers. When analog audio is selected, only channels 1 & 2 will be available at the 
analog output. Embedded channels 3 and 4 are not affected. 

• User bits in the SDI embedded audio stream are not supported. 

• 20 bit Dolby E is supported 

Configuring Embedded Audio 

From the GUI window, click OPTIONS->CONFIGURE from the Transport View of Channel 1.  
The Channel Configuration window shown below will appear.  Use this window to configure 
Embedded Audio. 

 

 

Figure 25 - Channel Configuration Screen 
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Setting the Input Source 

Three buttons select the input source for video and audio.  These are: 

• CVBS/Discrete Audio (composite video with AES/EBU or analog audio inputs) 

• SDI/Discrete Audio (serial digital video with AES/EBU or analog audio inputs) 

• SDI/Embedded Audio (serial digital video with embedded audio)  

The discrete audio inputs can be either: two stereo pairs (4 channels) of AES/EBU digital audio, or 
one stereo pair of +4dBu analog inputs, as determined by jumpers on the audio card. 

Regardless of the input selected, audio will always appear in the SDI output stream as embedded 
audio, and at the discrete outputs as either AES/EBU (digital) or as +4 dBu balanced analog audio.  
The Image Server supports Group 1 embedded audio, which includes audio channels 1-4, 20-bit, 
48 KHz, synchronous audio, as per SMPTE 272A.  

The analog audio channels always input to and output from channels 1 and 2. Audio channels 1, 
2, 3 & 4 always correspond to their like-numbered Group 1 Embedded Audio channels. 

 

Note: When recording SDI, the SDI signal must be synchronous with genlock.   

 

 

Using Audio Sample Rate Conversion 
Two check-boxes are provided to engage built-in sample rate converters for either (or both) of 
audio channel pairs 1 & 2, and 3 & 4.  When checked, the incoming AES/EBU audio tracks are 
converted to a 48K broadcast standard synchronized by video genlock.   

 

The sample rate converters should be used in any of these cases: 

1. The incoming digital audio and video are not referenced to the genlock. 

2. The sync reference is set to INTERNAL. 

3. The incoming digital audio is not at 48 KHz sample rate. 
 

 

Note:  Audio sample rate conversion is not applicable for Embedded Audio and Audio Rate 
Conversion boxes will be grayed-out if the SDI/ Embedded audio check-box is selected, or if the 
XLR audio inputs are jumpered for analog audio. 



 

MAXX Owner’s Manual Page 71 

Using Channel Ganging 
Transport operations on Video Channels can be locked or “ganged” together to allow frame-
accurate key and fill material (either stills or clips) to be implemented. Channel Ganging might also 
be used to create certain types of presentations, such as synchronized matte backdrops on News 
Broadcasts. 
 
The channels can be ganged in the following combinations: 
 

1. Channel 1 controls Channel 2 
2. Channel 1 controls Channels 2 and 3 
3. Channel 2 controls Channel 3 
 

To configure Channel Ganging Click EDIT->CONFIGURE->TIMING from the Main Menu. The 
screen of Figure 26 is displayed. 
 
To select Channel 1 to be ganged with channel 2 only, set CHANNEL GANGING MASTER to 1 
and click the GANG checkbox on channel 2. 
 

To select Channel 1 to be ganged with channel 3 only, set CHANNEL GANGING MASTER to 1 
and click the GANG checkbox on channel 3. 
 
To select Channel 1 to be ganged with channel 2 and 3, set CHANNEL GANGING MASTER to 1 
and click the GANG checkboxes on channel 2 and channel 3. 
 
To select Channel 2 to control channel 3 set CHANNEL GANGING MASTER to 2 and click the 
GANG checkbox on channel 3. 
 
 

 

Figure 26 - Timing Configuration Screen 
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Using Ganging for Key and Fill operations  

Channel Ganging is most commonly used to support and Key and Fill operations. Ganging allows 
generation of frame-accurate key and fill material (either stills or clips).  This in turn is used with a 
downstream keyer or video effects generator to be externally combined with a third video source. 
Manual or automation control of the Master channel is all that is needed to play both the key and 
the fill.  

Key and fill clips are associated by their names. The Key Clip must have the same name as the Fill 
Clip with a trailing underscore. Example: 

Fill clip name:  myfile 

Key clip name:  myfile_ 

There is no provision for automatic loading of similar named clips on more than two channels - the 
Master channel and the next higher numbered Ganged channel. Additional channels must be 
loaded manually, after loading the master channel. 

Proper key and fill operation requires two clips of identical length. This can be accomplished by 
editing with head and tail trim.  Long GOP mpeg clips should not be used if editing will be 
required to allow precise head point positioning.   

Channel 2 is ganged to Channel 3 in the following example.  

When a clip is opened/cued on Channel 2, Image Server automatically looks for another clip with 
the same name, plus a trailing underscore.  If the clip is found, it is loaded on Channel 3.  The 
Channel 2 clip contains the “fill” material, while the Channel 3 clip has the “key” (or alpha) file. 

An automation system, could, for example, issue a VDCP Cue command to Channel 2 for a clip 
called “logo”.  Channel 3 would automatically be loaded with clip “logo_”.  A Still or Play 
command sent to Channel 2 would cause both Channels 2 and 3 to display the fill and key clips, 
respectively. 

Note that the VDCP checkbox option to “show first frame” for a Cue command is ignored for 
channels in ganged mode.  The automation system must issue a Still command to Channel 2 to 
achieve this effect. 

Ingesting a TARGA file via FTP automatically creates a key clip and a fill clip, each a single frame 
in length.  For example, if file “xyz.tga” is transferred to an Image Server via FTP, then a pair of 
single-frame clips is created:  “xyz” and “xyz_” containing the fill and key material. 

Using DV Video and Graphics 

Playback of DV-format video and TARGA Graphics is included.   It plays DV-25 files in native 
format, and TARGA graphics files including those with key and fill.  DV and Graphics enables 

direct FTP import from Photoshop®, After Effects®, Final Cut Pro®, Xpress DV/Pro™, Liquid Edition 
and Vegas video. 

With DV and Graphics, Image Servers are able to function as both a graphics still-store and an 
animation playout server.   Its three simultaneous outputs give it the power to combine video, 
graphics and animation playback. Channels can be ganged in various combinations to provide key-
and-fill playout, while Channel 1 plays background video.  The following capabilities are included: 
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Importing TARGA Graphics Files 

The Image Server will recognize and ingest single-frame TARGA files via FTP from most network-
attached graphics workstations.  TARGA files have a .tga extension, and may contain an alpha (or 
key) channel.  During transfer, the Image Server will split the TARGA file into a Fill frame, and a 
Key frame if it exists.  These will be converted to high-resolution MPEG-2 files, one frame in length.   

For example, if an original file is named Logo.tga, the MPEG-2 files created will be named 
Logo.mxf (the fill file) and Logo_.mxf (the key file).  Note the trailing underscore “_” added to the 
file name of the key.  This allows the TARGA file to be used for key and fill applications when 
channels 2 and 3 are ganged together.   

Once a TARGA file is ingested, it exists only as an MXF MPEG-2 file.  The processed file may be 
transferred to-and-from network-attached storage, another Image Server, or a graphics workstation, 
as two separate MXF MPEG-2 files. 

The resolution of a TARGA image should be 720 x 480 for NTSC video or 720 x 576 for PAL.  If 
the original TARGA image is not of this resolution, the Image Server will re-scale it, possibly 
introducing some dimensional distortion.  The bit depth of the files must be 24 or 32 bit. The 
Image Server does not support Targa sequences, only single frame graphics. 

Animation Import 

From the Image Server’s standpoint, an “animation” is a clip with a minimum length of two 
seconds. Clips used in back to back seamless playback must be a minimum of four seconds long. A 
separate Alpha channel may or may not be present.  Any graphics workstation capable of exporting 
files supported by the Image Server can make transfers to it via FTP.  If an alpha channel is present, 
the naming conventions of the Key/Fill Mode apply: the file name for the key video is the same as 
the filename for the fill video with the addition of an underscore character ( _ ).  Many software 
programs have the ability to create content compatible with the Image Server , including Final Cut 
Pro® 4, Avid® DV Xpress, DV/Pro, Liquid Edition, Vegas video, and Adobe® After Effects®, 
Premiere® and Photoshop®.  

Still Frames 

A single-frame clip (a “still”) may be inserted into a playlist.  The length of a still will appear as one 
frame in the clip list.  When a still is encountered, the playlist will pause and hold the still image 
until a Play command is issued, at which point the playlist will continue to the next clip in the list.  
When using the GUI, the space bar (a keyboard shortcut) will also advance the playlist.  Stills may 
be placed anywhere in a playlist.  In fact, a playlist may be entirely composed of stills.   

A still frame clip in a playlist can have a duration assigned to it (See page 65 ).  It will then play for 
that duration and the list will continue automatically. 

Stills are created when TARGA files are ingested. (See page 77 for a description of TARGA file 
ingest.)   It is also possible to create still frames from video clips that use a 1 frame GOP (I-frame 
only.)  When editing the clip, make the In and Out points the same frame.  This frame will be 
displayed when the clip is played in the Playlist.  
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FTP File Transfers 
Image Server features Gigabit Ethernet connectivity using an RFC-1359 compliant FTP server. File 
transfers to and from the Image Server are managed from an FTP client file transfer program 
running on a Windows® or Macintosh® computer.  This provides a rapid way to execute drag-and-
drop file transfers; it can also manage many Image Servers at once and does not tie up the Image 
Server GUI, which may already be in use. Table 2 indicates the supported FPT client list.  
 

FTP Client Version Platform 

Flash FXP 3.2.0 WINDOWS XP, WIN2K 

DOS FTP 5.1.2600 WINDOWS XP, WIN2K 

WS FTP 5.08 WINDOWS XP, WIN2K 

Internet Explorer 6.0.2900 WINDOWS XP, WIN2K 

Fetch 5.2 MAC OSX 

CyberDuck 2.7.3 MAC OSX 

 
Table 2 - Supported FTP Clients 

 
FTP programs may also be used to move recorded or edited material between an Image Server and 
Network Attached Storage (NAS) or a DVD-ROM library. 

From a networking or system-integration viewpoint, the Image Server appears as a normal FTP 
server in any size network, with the exception that it may only send, receive, or store video files 
that are compatible with the Image Server. 

 

The Image Server is designed to be used in a private dedicated video network.  A firewall 
must be used in systems that require internal security or connection to public networks. 
Consult with a network security specialist for guidance on the best hardware, 
programming and practices for your facility’s requirements. 

Gigabit Ethernet Cable Quality 

The high data rates generated by Gigabit Ethernet require high-quality cable designed for this 
application.  Low-quality network cables can result in high error rates and lower transmission 
speed.  For Gigabit operation, standard CAT-5 cable should be used only for very short cable runs. 

New Category 5e (enhanced) cables ensure maximum transfer rates, and should be used as the 
minimum standard.  Category 6 cable is a more recent product designed for applications where 
longer cable runs are required.  

Configuring the FTP interface 

Before logging in to the Image Server’s FTP server, the network must be configured according to 
the local network topology. This is primarily a matter of setting a static IP address or configuring  
MAXX to use DHCP to obtain an IP address from a DHCP server. Refer to page 48 for details on 
configuring the network settings. 
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If you will be connecting directly to a PC or Laptop, configure the Image Server as IP address 
192.168.1.3, netmask 255.255.255.0 and disable DHCP.  In the PC, double click on the Local 
Area Connection Icon in the system tray or in the Network and Dial-Up Connections in the Control 
Panel. In the Local Area Connection Status dialog, click on Properties. Click on the item “Internet 
Protocol (TCP/IP)” and click on Properties again. In Local Area Connection Properties, turn off 
“Obtain an IP Address Automatically“ by selecting “Use the Following IP Address” and set the 
address to 192.168.1.2, netmask to 255.255.255.0. 

No hardware settings are available or needed.  The NETNETNETNET----1111 port automatically negotiates port speed 
and configures transmit and receive connections, and does not need a “crossover” cable when 
connecting directly to a PC. 

The actual transfer rate depends on the format of the files being transferred, the number and bit rate 
of video streams being played.  In practice, broadcast content encoded at 12 Mb/sec should 
transfer at a rate five times faster than real time, even while the server is playing video. 

 

Logging in to the Image Server FTP Service  
The Image Server allows only for anonymous login. Using one of the FTP clients shown in Table 2, 
enter “anonymous” as the user name or check the “anonymous” checkbox on the login screen.  

When the FTP client is connected, it will display the Clips in the main directory and all of the sub-
folders. Clips can be uploaded, downloaded, deleted and renamed using standard FTP client 
commands.  Clips in the subfolders can be displayed by entering those folders.  Consult the 
documentation for your FTP client for information on changing folders. 

The Image Server will support two simultaneous data transfers (2 in, 1 in and 1 out or 2 
out.)  There can be up to two additional FTP sessions active for other purposes such as 
viewing the directory. 

 

File Sizes Reported in Listing 
The size of a clip reported in the file listing is the amount of video and audio data included 
between the In/Out points. 

Overwriting Files 
It is the responsibility of the client application (Windows Explorer, FlashFXP, etc) to ask the user if 
they want to overwrite a file. 

Note that some types of files (such as .avi and Targa) change their file extensions when they have 
been transferred into the Image Server.  In these cases, the FTP client cannot warn of a file 
overwrite. It is important to take extra care when using these types of files not to overwrite 
necessary files. 

Interrupted and Resumed Transfers 
If a transfer is interrupted (for example, by a dropped connection) the amount of the file that has 
been transferred is kept on the target system.  Resumption of a partial transfer is possible if the FTP 
client supports it. 
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Transfer of Edited Segments 
The Image Server sets MARK-IN and MARK-OUT points in a clip as “edit pointers.”  For all edit 
operations within a given Image Server, these pointers produce “virtual edits” that save disk space, 
and the time it would take to re-write the marked region as a new file. 

It is clearly impractical to transfer a long file to obtain a 30-second virtual clip marked within it.  
Therefore, the Image Server transfers only the region between In/Out points, and not the entire file.  
If you want to transfer the entire recording, be sure that the In/Out markers are set to the beginning 
and end of material before the transfer. 

To maintain the identity of the transferred clip, the time code references for its Mark-In/Out points 
are maintained, as shown in Figure 27.  (Note that DV files do not contain a start time, so all 
segments of edited DV format clips will start at 00:00:00 after being transferred.) 

When transferring edited material, keep in mind that you are making copies of the data on the 
target device.  While subclips that reference the same video content on the original recordings take 
up minimal extra disk space, they could take considerably more space on the target storage.  
 

 

Figure 27 – Result of a network file transfer 

 

Supported file types 
MAXX recognizes media file types by their file extension.  It is important that the file extension 
properly identifies the file content.  Attempts to send a file in one format but masquerading as 
another due to a wrong file extension may result in undefined behavior.  The following formats are 
supported: 
 

MXF - Material Exchange Format (.mxf) 

The Image Server supports FTP import and export of MPEG-2 files in MXF format conforming to 
operational pattern 1A.  The video essence must be a standard-definition (NTSC or PAL) MPEG-2 
elementary stream, including D10.  The audio essence must contain 16 or 24 bit samples, sampled 
at 48000 Hz, organized as a single track containing 1, 2 or 4 audio channels.  Applicable standards 
are SMPTE 377M, 378M and 381M. 

01:22:18;04 

00:30:00;00  

(IN POINT) 
00:32:00;00 

(OUT POINT) 

CLIP_A.mxf  

Before Transfer (On Source Image Server)  

00:30:00;00 00:32:00;00 

CLIP_A.mxf 

After Transfer (On Target Image Server) 
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DV Stream (.dv)   

The Image Server recognizes DV25 (25 Mb/s) stream files containing multiplexed video and audio 
according to SMPTE 314M. The audio must be 48 KHz sample rate locked to video.  The .dv file 
extension is maintained, allowing transfer of .dv files between Image Servers and graphic 
workstations without modification. DV50 is not supported. 

AVI Files in DV format (.avi) 

An AVI file is a container that encapsulates a wide range of audio and video formats.  The Image 
Server can recognize only DV AVI Type 1 and Type 2. Type 1 .avi files contain a single stream of 
multiplexed audio and DV25 format video as described above.  Type 2 .avi files contain separate 
audio and video (even though the video may contain the same or different audio interleaved.) 
During ingest of .avi files, the server will convert the file into a DV stream (.dv) for storage and 
future FTP transfer.  When the resulting .dv file is exported, if it was originally a type 2 it will 
contain the .avi audio, not any audio that may have been present in the DV video stream. 

MPEG-2 Program Stream (.mpg, .std) 

Standard-definition MPEG-2 program streams containing up to 2 stereo pairs of 16-bit, 48K, 
MPEG2 Layer 1 audio are supported.  16-bit audio files will be written into a 24-bit space. 

TARGA (.tga) 

24 or 32 bit format (16 bit format is not supported.) During transfer, the TARGA file will be split 
into a Fill frame and a Key (Alpha) frame.  These are saved as two separate MPEG-2 clips, each one 
frame in length.  The clip name for the fill frame is the base name of the .tga file, while the key 
frame has this name with an appended underscore character. The resulting files will be available as 
MXF files for subsequent FTP transfer. 

PES – Packetized MPEG-2 Elementary Stream (.mp2, .m2v) 

The Image Server will accept MPEG-2 standard-definition elementary stream files.  These contain 
video-only, no audio.   

Wave (.wav) or Wave-64 (.w64) 

The Image Server will accept WAVE or WAVE-64 files containing only audio.  Audio files should 
contain 24-bit stereo pairs sampled at 48 KHz.  The resulting audio-only clips are available for play 
out, but do not appear in the FTP directory listing for subsequent transfers. 

Playlists (.lst, .txt) 

An Image Server play list is a text-based file residing in the /lists directory.  Play lists can be created 
off-line and transferred to the Image Server using FTP.  See page 132 for further information on 
Playlist file editing and management. 

As-Run Logs (.arl) 

As-Run logs are available from FTP to confirm the operation of the Image Server Advanced Playlist 
feature.  See page 63 for further information on using As-Run logs. 
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Network Time Protocol 

Automatic Date/Time Updates 
When using Image Server play-lists in broadcast applications, an accurate record is often needed of 
what was played and when.  The Image Server’s As-Run logging feature creates such a record, time 
stamping each played clip using the machine’s internal date/time clock.  Very accurate time 
stamping can be achieved by synchronizing the server’s clock to an external time base that is 
referenced to Coordinated Universal Time (UTC). 
 
This is accomplished using the Network Time Protocol (NTP) to interrogate time servers through a 
network connection.  A time server could be an in-house computer that is equipped with a GPS 
receiver, or a radio receiver locked to signals from the NIST radio station WWV.  Alternatively, 
public time servers may be used which are accessible through an Internet connection. 

Connecting to the Network 
To obtain automatic date/time updates from the public time servers on the Internet, you will need 
to provide the Image Server with Internet access.  Generally, Image Servers would be connected on 
a secure high-speed local area network, with any Internet connection going through a router with 
an integrated firewall.  The Network Time Protocol uses TCP/IP port number 123, so be sure the 
firewall is configured to allow access to this port per Figure 28. 
 
 

 

Figure 28 - NTP Network Block Diagram 
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Configuring NTP 
The Image Server GUI is used to set the time zone and to enter the networking parameters.  The 
local GUI must be used, as these configuration screens are not available on the Remote 
Workstation Interface.  
 

Selecting the Time Zone 
Starting at the main menu bar, Click Edit->Configure->Date-Time screen.  When “Automatic 
Updates” is not checked, the Region and Zone lists are enabled.  Select your region and then the 
zone within that region.  There may be more than one way to your zone; America/New_York, for 
example, is the same as US/Eastern. Click the APPLY button to activate the settings, 
 

After changing the time zone, you must perform at least a Quick Restart before the changes 
become fully effective. 

 

 

Figure 29 - Date/Time Configuration Screen 
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Entering Network Parameters 
From the GUI’s main menu bar, Click EDIT>CONFIGURE>NETWORK. The screen of below 
appears. Make sure the basic network parameters have been entered. 
 

 

Figure 30 - Network Configuration Screen 

 
Disable Network:  uncheck 

Host Name:  (Any name will suffice, but since this name appears on each line of the Image Server’s 
diagnostic logs, it is a good idea to keep this short.) The name should also be unique from other 
devices on the network. 
 
If “Use DHCP” if not checked, then enter a fixed IP address compatible with your local subnet.  For 
example, 

IP Address:  192.168.1.20 
Net Mask:  255.255.255.0 
Default Router: 192.168.1.1 
 
The Name Servers and NTP Servers fields provide the information needed to reach the public time 
servers. 
 
The NTP Servers field contains a list of time servers, either by numeric IP address, or by site name 
(URL).  Entries are separated by spaces. 
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The nonprofit Internet Systems Consortium, Inc. (ISC) maintains sites that automatically return lists 
of public time servers to an NTP client such as the Image Server.  Hence, the NTP Servers field is 
initially filled in with the URL’s for these sites (0.pool.ntp.org, for example).  Of course you can 
overwrite this list with the addresses of specific time servers you may want to use.  However, if you 
try to clear the NTP Servers field it will be reset to the default list. 
 

Note: When URLs (non-numeric site address such as pool.ntp.org) are used in the NTP Servers 
field, you must provide the IP address of at least one DNS (Domain Name Server) in the Name 
Servers field.  Typically, this address is supplied by your Internet Service Provider.   

 
These name servers translate URL names into numeric IP addresses needed to access the sites in 
question. 
 
If you are using a GPS-based time server for instance, that is connected directly to your local area 
network, enter its numeric IP address (such as 192.168.1.60) into the NTP Servers field, leaving the 
Name Servers field blank. 
 
Also, if you know the numeric IP addresses of the public or corporate time servers on the Internet, 
you can enter these addresses, separated by spaces, in the NTP Servers field, leaving the Name 
Servers field blank, since there would be no URLs to be resolved.  
 

Note:  Not all Time Servers allow unlimited public access. Refer to www.ntp.org for more 
information.   

 
 
Click the APPLY button to save your changes. 
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Automation Control 
 
MAXX provides standard RS-422 serial control ports that allow operation with many broadcast 
automation systems, instant replay panels, video switchers, and remote control devices.   
For compatibility with simple controllers and push buttons, the server also provides six GPI 
(contact closure) inputs, and six programmable-command outputs. 

Remote Serial Control 

The Image Server’s three 9-pin serial control ports permit independent control of its three video 
channels.  MAXX supports the following serial protocols. 

1. VDCP 
2. SONY BVW ( 9-pin ) 
3. ODETICS Extension to the SONY BVW ( 9 pin ) protocol 

 

100 - 240 VOLTS, 50 - 60Hz, 2 AMPS MAX
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Figure 31- Rear Panel Detail of Serial Ports 

 
CH1 - RS-422 Control Channel 1, also referred to as COM1 
CH2 - RS-422 Control Channel 2, also referred to as COM2 
CH3 - RS-422 Control Channel 3, also referred to as COM3 

 
When using VDCP, Each port can also respond to channel ID numbers that are equal to, or 

multiples of, its base number.  For example, channel 1 will also respond to 4, 7, 10, etc.  This can 
be helpful when an automation system needs to control a number of Image Servers at once  

 

The server’s multiple serial ports allow simultaneous connection of an automation controller and 
a desktop editing controller.  This way, one could configure an edit controller on Channel 1 for 
record, playout, and editing; while an automation controller on Channel 2 manages play-to-air 
operations.  Alternatively, a single controller could control the operation of all Image Server 
channels.   

 

It is also possible for a single VDCP controller to control multiple Image Server channels. 

CH1 CH2 CH3 
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Controller Priority 

Only one serial controller can control a given video channel at a time. In general, the first 
controller to gain control of a video channel will have exclusive command.  This prevents 
conflicting instructions that would cause unexpected behavior.  The only exception is that the 
graphic user interface can immediately take control of a channel by selecting Serial Control in that 
channel’s dialog window. 

External controllers are prohibited from taking control away from the GUI, the SERIAL CONTROL 
mode must be checked in the channel dialog window before a remote control device can 
communicate with that channel. 

Configuring the automation interface 

Setting the automation protocol for a video channel 

Each of the three video channels can be configured independently for one of the following 
protocols. 

1. VDCP 
2. SONY BVW 
3. ODETICS 

 
To map a protocol to a channel, Click EDIT->CONFIGURE->SERIAL PORTS from the main 

pull-down menu. The screen of in Figure 32 is displayed. Use the PORT pulldown to select 
COM1, 2 or 3. These map to Video channels 1, 2 and 3.  

• Select VDCP to map the port to VDCP protocol 

• Select BVW to map the port to SONY BVW protocol 
• Select BVW to map the port to ODETICS protocol 

 
 

NOTE: 
VDCP operation can allow control of a channel by ID number from a different 
numbered serial port, while BVW and Odetics protocol control only the channel 
number corresponding to the number of the serial port in use.  Take care if using 
both protocols not to allow VDCP controllers to address a channel that is controlled 
by BVW/Odetics on another serial port. 
If necessary turn on “Assigned Serial Ports” in VDCP Options – this will force VDCP 
to control the channel corresponding to the serial port it is connected to regardless 
of the channel ID in the control messages. 
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Figure 32 - Serial Port Configuration Screen 

Other Automation Options  
As illustrated in Figure 32, a number of check boxes are provided that control how the Image 

Server will respond to certain VDCP commands.  Once set, these options remain selected when 
the server is turned off, and until changed by the user. 

NOTE: The following options will apply to all three video channels. They cannot be individually 
configured for each video channel. 

 

Cue Shows 1st Frame 

Upon receiving a Cue With Data or a Play Cue command, the server will cue the clip then jog to 
and display the first frame of video. (This also applies to Odetics protocol.) 

Cue with Offset (vs. Timestamp)  

When checked, the time code for the clip becomes “zero-based” with reference to the head 
point.  To move to the head point of the clip, the automation controller would send a time code 
value of 00:00:00:00, regardless of the clip’s original time stamp.  When unchecked, the Image 
Server will calculate time code position based upon the time stamp from the first frame of the 
unedited clip.  Note that this only affects the operation of the serial port, it does not change the 
way the Image Server displays time code in the GUI. 

Vari-Play 1X Equals Play 

The Image Server will interpret a Vari-play 1x command as a Play command. (This also applies to 
Odetics protocol.) 
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Vari-Play 0 Equals Pause 

The Image Server will interpret a Vari-play 0x command as a Pause command. (This also applies 
to Odetics protocol.) 

Report Play (vs Still) At End 

When the end of a clip is reached, the Image Server will report Play to the automation controller, 
instead of Still. 

Ignore Preroll Commands 

A minimum 10-frame pre-roll is required to allow the server time to respond to serial commands.  
See the documentation for your controller or automation to find out how to set the preroll value. 
Due to variations in the way preroll commands are implemented in various systems, it may be 
sufficient to check this box only. The setting of 10 frames in the controller will then work correctly. 

This option is very seldom used, it allows preroll commands to be ignored and assumes that the 
operational preroll is 10 frames. Do not check this unless you experience problems with frame 
accuracy on recordings and playback transitions.  Start with a setting of 10 frames on the 
automation system and adjust until you achieve proper timing. 

Auto E-E 

Toggles Auto E-E mode (input monitor) on/off. 

Assigned Serial Ports  

VDCP protocol provides for altering the mapping of Serial Port to Video Channel via 
control commands. Checking this option will lock the Serial Port to Video Channel 
ordering.  

• When checked, any command received on a particular serial port will be used to 
control the like numbered video channel.  This means that automation systems that 
use fixed or limited VDCP ID numbers can use any output to control any channel of 
the Image Server. 

• With this option checked, there is no requirement for a Port Open command to 
allow the automation to control the channel.  With some systems, this can negate 
the requirement to restart the automation system when bringing the Image Server 
online. 

• Do not check this option when using controllers that communicate with all 
channels over a single serial port, such as Leightronix ® TCD/IP. 

 

Communication Port Parameters 

The serial data transfer parameters for the Image Server are fixed and cannot be changed.  These 
characteristics are common to all automation controllers: 

Baud Rate 38.4 K Baud 

Start Bits 1 

Data Bits 8 

Parity Odd 

Stop Bits 1 
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Tested Automation Controllers 
The Image Server has been tested by 360 Systems and the manufacturers of equipment listed 

below, and found to operate correctly.  This list is not comprehensive, and the inclusion or 
absence of a product does not indicate a preference for any make or model.  Operational variations 
do exist between makes and models.   

 
Manufacturer Controller Protocol Notes 

HARRIS AUTOMATION  ADC-100 VDCP ALL HARRIS CONTROLLERS SAME 

SUNDANCE FAST BREAK VDCP  

NVERZION EMC-NT  VDCP  

CRISPIN CORP. SYSTEM 2000 VDCP  

FLORICAL AIR BOSS VDCP  

VCI SOLUTIONS (DTG)  AIRO VDCP  

LEIGHTRONIX TCD/IP VDCP  

TIGHTROPE MEDIA CABLECAST ODETICS  

HARDATA HDX VIDEO ODETICS  

IBIS ITA VDCP  

PEBBLE BEACH SYSTEMS ANEMONE VDCP  

PROBEL MORPHEUS VDCP  

PHAROS PLAYTIME VDCP  

AVECO ASTRA VDCP  

THOMSON-PARKERVISION PVTV-PLUS NEWS VDCP ALL CR SERIES 

 

Tested Remote Control Panels and Switchers 
The Image Server has been tested by 360 Systems and manufacturers of the remote control 

devices and video switchers listed below, and found to operate correctly.   

 

Manufacturer Controller Protocol Notes 

ROSS VIDEO SYNERGY® SWITCHERS VDCP  

ECHOLAB OPERA SWITCHERS VDCP  

DNF CONTROLS 4000-CL VDCP ALSO USED WITH DNF SHOT BOX 

DNF CONTROLS 300-SSM P2 BVW-75, ALSO ODETICS PROTOCOL 

ASH VALE  SM-2 P2 SLOW MOTION CONTROLLER 

BUF VTC-4000 P2 BVW-75, ALSO ODETICS PROTOCOL 

BUF SPOT VDCP ALSO ODETICS PROTOCOL 

LANCE DESIGNS TDC-100 ODETICS USE INT MODE 

HI-TECH  SYSTEMS ACTIV CART BOX VDCP ALL VDCP PRODUCTS SAME 
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Remote Workstation Interface 
 
The Image Server Remote Workstation Interface is a software application that provides IP control 

of the server from PC workstations located within a facility.  

A remote workstation can access one or more video channels of an Image Server to perform 
ingest, playback, trimming, playlisting, traffic operations or monitoring of server activities.  

 

Applications include— 

• Control of an Image Server located in a machine room 

• Ingest station for loading commercials and other content from tape 

• Edit station for trimming content 

• Building, editing and running playlists 

• Remote control of an Image Server located at a transmitter site (“evergreen” backup) 

• Access to file content and operations by engineering or management 

• Control of more than one Image Server from a single workstation 

• On a wireless network, an Image Server can be controlled by a secure  
Wi-Fi enabled laptop computer 

• Remote control in a conference room, or during auditorium presentations 

• Image Servers may be securely controlled from a remote location, even across public Internet 
connections, with inexpensive VPN (Virtual Private Network) technology. 

A single Image Server may be controlled from many remote workstations, at different locations on 
the network. See Figure 33. 

 
Similarly, a single computer can run multiple Remote Workstations to control multiple Image 

Servers. 

 

Remote Workstation provides the same functionality as the local GUI with the following 
exceptions: 

 

• Remote Workstation cannot access the servers Network configuration screen 

• Remote Workstation cannot shutdown the server. 

• Remote Workstation cannot access the RAID status display 

• Remote Workstation cannot display MAXX’s time-of-day clock. 
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Figure 33 - Remote Workstation Deployments 

 

System Requirements 

• PC with Windows XP or Windows 2000 installed.  Other operating systems have not been 
tested and as of this writing are not supported.  

• 6 MB free space on the computer hard disk, plus 64 MB RAM. 

About the Remote Workstation Interface 

The Remote Workstation Interface consists of a CD-ROM carrying the Remote Workstation 
application for Windows 2000 and Windows XP computers.  It self-installs using the normal 
Windows prompts.  

It is possible to install the Remote Workstation software on a number of PCs; any of them can 
then control an Image Server. 

Operations 

Up to three Remote Workstations can simultaneously view the channel activity of a single Image 
Server.  Only one Remote Workstation, however, can take control of a video channel at any given 
time.  Control of the Image Server video channel is not automatically granted to a Remote 
Workstation just by attempting to use the GUI; control must be actively taken, using the TAKE 
CONTROL option described below.  This allows remote monitoring of Image Server channel 
activity while greatly reducing the likelihood that a remote user will interfere with operations 
initiated by another.  All Workstations, including the Image Server’s local GUI, have equal priority 
and any can take control of a video channel at any time.  Control is granted for server channels 
individually, and not automatically for all three; therefore, three Remote Workstations can each 
control a separate video channel.  Each Remote Workstation can display or close transport 
windows without affecting other Workstations or the Local GUI. 
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The IP address of a Remote Workstation currently controlling a channel appears in the status bar 
on the bottom-left of the Playlist or Channel window. 

A menu labeled Options appears at the upper-left of each Image Server channel window. 
Clicking this menu presents a drop-down menu with a TAKE CONTROL option.  Select this then 
click Yes in the confirmation dialog to give control of the video channel to your workstation.  

 

Installation 

To install Remote Workstation software from CD-ROM: 

• Insert the CD-ROM into the drive on a PC.   

• The auto-run capability of Windows will start the Remote Workstation setup program.  If it does 
not, select the Run… option of the taskbar Start Menu and type: D:\setup.exe. If necessary, 
replace D:\ with the drive letter of your CD-ROM. 

• You will be prompted to enter the IP address of the Image Server you wish to control.  If you 
know the address, enter it here.  This information can also be entered after installation. 

• You will be asked to agree or disagree with the terms under which this software is licensed to 
you. If you agree, installation will continue. If you do not agree, installation will stop. Follow 
the prompts to finish installation. 

• By default, the Remote Workstation software installs all required files into the  
C:\Program Files\ Image Server RWI folder.  However, during the installation process an 
alternate directory may be specified. If a previous version of Remote Workstation is already 
installed on the Host computer, use this feature to install the new version in a uniquely named 
folder, for example C:\Program Files\ISMAXX. 

After Installation 

A 360 Systems Remote Workstation icon will appear on your desktop.  Double click the icon to 
open a remote session on the Image Server.  To change the target Image Server you wish to access, 
right click on the Remote Workstation icon.  Select “Properties” from the drop-down menu.  In the 
“Target” text box, change the IP address listed in the box to the IP address of the Image Server and 
select “OK” or “Apply.”  Refer to Figure 34. 
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Figure 34 – Remote Workstation Properties Page 

 

Because multiple simultaneous sessions of Remote Workstation may be run on a single, it is 
possible to make copies of the Remote Workstation icon and change the IP address of each to 
allow one-click access to any number of Image Servers. Simply right click on the Remote 
Workstation icon and select Copy from the pop-up menu.  Next, right click anywhere on the 
desktop and select Paste.  Finally, follow the instructions above to edit the IP address to match the 
second Image Server. 
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Using Image Server With Final Cut Pro 
The Image Server IMX option coupled with Telestream’s Flip4Mac Image Server Component 
provides a “round-trip” compatibility with Apple Final Cut PRO, providing the following capability: 

• Record Industry Standard IMX Content. 
• Export IMX clips to Final Cut PRO over Gigabit Ethernet using the Flip4Mac Image Server 

Component Plug-in developed especially for Image Server. 

• Edit IMX clips in Final Cut PRO. 
• Export IMX clips back to Image Server for Playback. 
 

 
 

Requirements 
The following equipment is required to support Final Cut PRO interoperation: 

1. Image Server MAXX with IMX Hardware Option 300-102-0024-01     
2. Image Server software version 4.05.370 or later   
3. Final Cut PRO software version 5.0.4 or later   
4. Telestream Image Server Flip4MAC plug-in version 2.1.10.12   
5. Apple Macintosh computer “MAC PRO” including:   

a. Dual Core Xeon 2.66 GHz with  
b. 1GB DDR2 RAM minimum. 
c. NVIDIA GeForce 7300 GT graphics with 256MB memory  
d. 250GB Serial ATA 3 GB/s 7200-rpm hard drive 
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Recording IMX Content 
Image Server is capable of recording MPEG-2 material in SONY IMX format at 30, 40 or 50 Mb/s. 
This format must be selected if material is to be edited in Final Cut PRO. Material recorded in Main 
or 4:2:2 profiles cannot be edited on Final Cut Pro. 
 
From the Configure Window –> Choose Channel 1 

• Set the MPEG-2 Format to 4:2:2 IMX 
• Set the Max Bit Rate to 30, 40 or 50 Mb/sec. 

 

The use of 30 Mb/s is strongly recommended.  The additional quality of 40 and 50 Mb/s in most 
cases is not worth the extra disk storage space and transfer time required. 

Image Server 2000, MAXX 250 and MAXX 400 units can play 2 channels of 40 or 50 Mb/s IMX. 

• Select FILE>NEW from the channel 1 transport window 
• Press RECORD to begin recording. 

 

Transferring IMX Content from Image Server to Final Cut PRO 
Start Final Cut PRO. Make sure you have installed the Telestream Image Server plug-in. 

• Select File>Import>Image Server per Figure 1 
 

 

Figure 1 – File Import Menu 
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• A pop-up (Figure 2) prompts for the IP address, User Name and Password. Enter the IP 
address in the designated field. Enter Anonymous for the User Name. Click on CONNECT 

 

 

Figure 2 – Image Server Connect Screen 

 
A list of files on the target Image Server will be displayed per Figure 3. Click the check box on the 
file or files you want to import. Click the IMPORT button. 
 

 

Figure 3 – Flip4Mac’s Image Server File List Screen 

 
The file will upload. Load times will vary depending on data rate of the encoded material, the class 
of MAC you are using and whether the Image Server is busy playing out to air. Here are some 
examples of load times. In general, Import and Export times are symmetrical.  
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Clip Format Clip Duration Transfer Time - Idle Transfer Time - Playing Clips Playing 

30 Mb/s IMX 60 seconds 49 Seconds 57 Seconds 3 – 30 Mb/s 
40 Mb/s IMX 60 seconds 61 Seconds 63 Seconds 3 – 40 Mb/s 
50 Mb/s IMX 60 seconds 70 Seconds 73 Seconds 3 – 50  Mb/s 

 
Once the file is loaded it will appear as an icon that displays the first frame of the content and the 
name of the clip. Before material can be edited, the sequence settings in Final Cut Pro must be set 
to match the characteristics of the clip. This is important because if they do not match, Final Cut 
PRO will attempt to render the entire cut before it can be edited. This is fairly quick on clips of one 
or two minutes, but it can be unacceptably slow on longer clips. 
 

Check the Characteristics of the clip 
Mouse over the icon of the imported clip. Hold down the CTRL key and click on the icon. Select 
Properties from the pull-down. Make a note of the properties. If you will continually edit the same 
type of content you will not have to repeat this step. 
 

Set the Sequence Settings to match the clip characteristics 
Select Sequence->Settings. 
Configure the settings to match the properties of the clip. Of particular significance is the 
Compressor field. Here is an example of sequence settings for a 30 Mb/s IMX clip recorded on the 
Image Server: 
 
Property Setting for IMX @ 30Mb encoded on Image Server 

 NTSC PAL 

Frame Size 720 X 486 720 X 576 

Aspect Ratio NTSC – CCIR 601 (40:27) PAL – CCIR 601 (5:4) 

Field Dominance Lower Lower 

Editing Timebase 29.97 25 

Compressor MPEG IMX 525/60 ( 30 Mb/s ) MPEG IMX 625/50 ( 30 Mb/s ) 

Audio Rate 48 KHz 48 KHz 

Depth 16 bit 16 bit 

 
The only difference in the settings for 40 Mb/s and 50 Mb/s clips is the compressor used should 
match the bit rate. 

Once the Sequence Settings have been configured, drag the icon of the clip down to the timeline. 
If the settings are properly configured, a red line should not appear above the clip on the Timeline. 
If a red line does appear, recheck the sequence settings and clip properties and repeat the step 
above. 

Editing Content in Final Cut PRO 
Entire industries exist to educate and assist Final Cut PRO users. In summary, once the clip is on 
the Timeline, the first frame will be displayed in one of the television-like sequence windows. If it 
has been imported properly, you will be able to play it using the intuitive VCR-like controls in the 
window. It is important to select and work only on a specific region that requires editing. If a 
specific region is not selected, Final Cut PRO may render the entire clip every time you make a 
change. The rendering process is quite time-consuming.  Refer to relevant Final Cut PRO 
documentation for tutorials. 
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Exporting and Playing Content on the Image Server 
Once content has been edited in Final Cut PRO, it can be re-exported back to the Image Server for 
storage and playout as follows: 
 
Select File->Export->Image Server per Figure 4 
The same pop-up menu is displayed as for the file Import function. Enter the IP address of the 
server and check ANONYMOUS login. The edited file will be exported via FTP to the server. 
 

 

Figure 4 – File Export Screen 
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Hard Disk Management 
 
Image Servers employ an advanced Serial-ATA controller that manages four high-capacity hard 
disks operating in a RAID-5 configuration.  This design increases system performance, and by 
storing parity data, helps prevent data loss should a drive fail. 

The Image Server brings a high level of reliability to Serial-ATA RAID through a new, switched 
architecture that exceeds the reliability of SCSI shared-bus storage systems.  The earlier shared-bus 
architecture of SCSI has inherent performance limitations due to arbitration latency, since only one 
drive may use the bus at a time.  Further, a single drive failure can bring the entire storage system 
down. 

By contrast, the Image Server uses a non-blocking switched architecture to isolate the drives from 
one another.  Any drive failure makes that drive unavailable and the rest of the storage system 
remains undisturbed.  In addition, the Image Server uses Advanced Data Protection features, where 
all drive commands are checked to ensure that no command corruption has taken place over the 
entire data path. 

Some of the Image Server RAID implementation features and benefits include: 

• Non-blocking switch technology with RAID 5 parity 
• On-board processor minimizes host CPU overhead 
• Easy-to-configure arrays  
• Dynamic sector repair for robust data protection 
• Accelerated RAID-5 writes 
• Easy drive replacement from front panel 

About RAID 5 
A RAID 5 configuration features the data striping of RAID 0, combined with the parity benefits of 
RAID 4.  Using a parity (exclusive OR) function, RAID 5 can tolerate the loss of one drive.  Parity 
information is distributed across all drives rather than being concentrated on a single disk.  This 
avoids throughput loss due to contention for the parity drive.  Spare drives can be used to rebuild 
an array after a drive is replaced. 

RAID-5 capacity equals the size of drive times (number of drives -1).  In addition, the array’s 
storage efficiency increases with the number of disks; from 66.7 % for 3 drives to 75 % for 4 
drives: storage efficiency = (number of drives -1) X (number of drives). 
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Figure 21: RAID 5 Array Schematic 

Improved Write Performance 
The Image Server uses new designs to improve RAID-5 write performance for both large 
sequential and small random transactions.  This advanced block caching firmware delivers 
extremely high performance for RAID-5 write operations. 

Managing Disk Arrays 
The Image Server’s Disk Array Configuration Utility provides tools for monitoring and 
managing the disk array.  Monitoring and troubleshooting programs automatically check the 
array, report problems and provide access to RAID status information and service options.  

A single drive fault should not cause data loss; but remember: the drive array is degraded and 
no longer has storage redundancy.  Hence, another disk failure may cause a complete loss of 
data and system failure.  After a drive failure it is strongly recommended that at the earliest time 
diagnostics be performed, and the server be taken off line while the RAID array is rebuilt. 

Error Notification and Repair 
The Image Server will notify users in the event of a fault by flashing the front panel DRIVESDRIVESDRIVESDRIVES 
light.  A flashing DRIVESDRIVESDRIVESDRIVES light can be triggered by a variety of conditions.  The first step in 
response to a flashing light is to open the RAID CHECK STATUS window from the On-Screen 
Start Menu.  Click Start > System > RAID Status to launch the Array Configuration Utility.   
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The RAID Status window (Figure 23) displays the current status of the RAID controller and all 
disks connected to the RAID system.  On inspection, you will find the array in one of the 
following states: 

• OK, indicated by "OK" for Array Unit 0 and all Ports (drives); 
• Initializing, indicated by "Initializing" on the Array Unit 0 status line; 
• Degraded, indicated by "Degraded" on the Array Unit 0 status line; 
• Rebuilding, indicated by "Rebuilding x%" on the Array Unit 0 status line. 

 

“Rebuilding” is the process by which the array controller corrects data parity errors that may 
have occurred because of power loss, incorrect shutdown or some other data error.  Upon 
detection of a parity error, the controller will automatically start the initialization process as a 
background task.  This task should not interfere with Image Server’s ability to record or play 
clips. 

Parity errors may occur if the Image Server loses power, or is improperly shut off.  No data will 
be lost, but the parity re-initialization process may take several hours.  NEVER use the rear 
panel power supply switch to shutdown the Image Server. Shut down the system only by 
momentarily pressing the front panel power button or selecting Start > Shutdown > 
Shutdown from the graphic user interface.   

Note that in some cases the power may not automatically shut off after a Shutdown is executed.  
When the front panel LED indicators start flashing in response to the Shutdown command, the 
file system has been successfully closed and it is safe to force the power off by holding the 
power switch in for 4 seconds. 

A degraded array with a drive listed as “Not In Service” or “Inaccessible” is usually indicative of 
a permanent drive error, typically a single disk or cable failure, but redundant data will allow 
normal operations to continue.  You may first try to rebuild the array with the existing drive still 
installed.  If the array continues to indicate a failed drive, replace the drive and then rebuild the 
array.  A hard disk array must be repaired using exactly the same drive model and capacity as 
other drives in the array.  Because specific drive models become unavailable as time goes on, 
360 Systems recommends that maintenance spares be purchased at the same time as the Image 
Server.   
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Log-In to the RAID Utilities  

 
Figure 22: Log-In to RAID Utilities 

 

To log in to the RAID utilities, perform the following steps.  The above drawing will appear. 

• Open the RAID utilities by selecting START>SYSTEM>RAID STATUS 

• In the Login window, enter ADMINISTRATOR.  

• In the Password window, make no entry; leave it blank.  In the event this does not work, 
use the password “3ware”. 

• Click the Login button to enter the Login Utilities. 
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Determining the Condition of the RAID Array 

Figure 23: Report of RAID Array Condition 

 

To replace a failed drive in the RAID control utility, perform the following steps.  The above 
drawing should appear. 

• Login as ADMINISTRATOR. 

• Note the ERROR STATUS on this Summary Screen. 

• If an error condition is indicated continue to next page.  
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 Displaying the Alarm Log of the Raid Array 

Figure 24: Checking Status of RAID Array 

 

The RAID controller keeps track of any condition that would adversely affect its reliability.  In 
the event that an error should occur, the alarm log will be helpful in diagnosing the problem.   

The above drawing will appear. 

• Select MONITOR>ALARMS from the screen. 

• Make note of any error conditions reported, and what Port numbers they refer to. 

Some examples of error messages are: 

Drive Timeout Error – The drive failed to respond to a command from the controller within the 
allotted time.  This is sometimes a benign condition, but often indicates a hardware problem 
with the drive. 

Drive Error – The drive reported a data error.  A rare isolated occurrence may be acceptable, 
but probably indicates a drive failure. 

Drive SMART Threshold Exceeded – The drive’s self diagnostic program is reporting an 
impending drive failure.  The drive should be replaced. 

Remapping Bad Sector – This is a normal function of a hard drive’s self maintenance. As a 
drive ages it is normal for sectors to fail, these are reassigned to a different part of the drive. 
Several may occur within a very short period (seconds to a few minutes.).  Multiple such errors 
within a few days may indicate an impending drive failure. 

Unclean Shutdown Detected – Power was lost without an orderly shutdown sequence, and 
the parity information was not updated. 
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Checking Status of the Drives  

Figure 25: RAID Maintenance Display 

 

To check the status of the RAID drive array, perform the following steps.  The above drawing 
should appear. 

• Select MANAGEMENT>MAINTENANCE. 

• Note the status of each drive in the array. 
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Removing the Degraded Drive from the RAID Unit 

Figure 26: Removing Failed Drive from RAID Controller 

 

The UNIT MAINTENANCE SCREEN above will appear. 

• Remove the degraded drive from the menu by clicking Remove Drive. 

• Select the Rescan Controller option on the above screen to have the system recognize 
the drive as Available. 
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Rebuilding the RAID Array 

Figure 27: Selecting a Drive to Use in Rebuilding the Array 

 

• Select Rebuild Unit.  The REBUILD SCREEN above will appear. 

• Select the available drive by clicking the check box. 

• Press OK.  The RAID array will begin rebuilding with the new drive.  This process may take a 
long time, but the Image Server can still be used.  

• When complete, OK will be shown in the status for all ports on the MAINTENANCE menu.  

Replacing Hard Drives 
The Image Server hard disk drives have been factory tested and configured in a RAID 5 array.  Each 
drive is numbered (0-3) and must be attached to the correctly numbered data cable.  Drive bays are 
also numbered. 

Please read Removing the Front Panel on page 106 for instructions on accessing the hard drive 
bays.  Detailed information about how to replace hard drives is on page 113. 
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Maintenance 

Fault Diagnostics 

Front Panel Indicators 
The five LED indicators on the front panel are used to diagnose server fault conditions.  The 
meaning of each indicator is noted in the following table.  During normal operation, all five 
indicators will be on. 
 

GENLOCK OFF indicates that the Genlock setting 
in the System menu is “Internal” 

FLASHING indicates that Genlock is 
selected in the System menu, but 
there is no signal, or an invalid signal, 
at the GENLOCKGENLOCKGENLOCKGENLOCK input connector. 

Check the Genlock setting in the On-
Screen System menu. 

Check the Genlock cable connections 
or signal. 

POWER FLASHING indicates that there is a 
fault in the system power supply. 

Shut down the Image Server and 
contact 360 Systems Customer Support 
for further hardware diagnosis. 

FANS FLASHING indicates that there is a 
fault of the internal chassis fan. 

Check the chassis fan operation.  
Replace if necessary.  Do not run the 
Image Server without a working fan. 

DRIVES FLASHING indicates that there is a 
fault in the system RAID array. 

Check the RAID array status using 
the utility under 
START > System > RAID STATUS. 

SYSTEM FLASHING indicates that the CPU fan 
is running slow, or stopped; or that the 
CPU temperature or voltage is not 
within manufacturer’s specification. 

Shut down the Image Server and 
contact 360 Systems Customer Support 
for further hardware diagnosis. 

 

 

Repairs should be performed only by qualified electronics 
technicians. 
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Gigabit Ethernet Indicators 
 
The Gigabit Server Adapter card has the following indicator lights: 

 Label Indication Meaning 

Green on The port is connected to a valid link partner 
Green flashing Data activity 

ACT/LNK 
(Left) 

 Off No link 

Off 10 MBps 
Green 100 MBps 

10=OFF 
100=GREEN 

1000=YELLOW 
(Right) Yellow 1000 MBps 

 

Access to Components 

 

Be certain to shut down the Image Server, turn off the rear panel power 
switch and disconnect the power cord before opening the unit for service. 

 

The following sections provide instruction on disassembly and re-assembly for maintenance. 

The front panel is removed to access the internal CD-ROM drive (for system program updates), or 
to service the hard drives. 

The top cover is removed to access the analog/digital audio selection jumpers, or to service an I/O 
card, the system board, or power supply. 

Removing the Front Panel 
The front panel is easily removed for access to the CD-ROM drive, the four disk drives, or for 
removing the server from an equipment rack.  Using a coin or a flat-blade screwdriver, unscrew 
the two large panel fasteners on the left and right sides of the face panel.  Hold the panel in 
place while undoing the screws.  Since the loosened screws are captive, you may use them to 
pull the panel away from the chassis. 

To re-install the front panel, tuck all wires into the chassis and move the face panel into 
position.  Screw the front panel fasteners back into the chassis.  Tighten the front panel access 
screws with a screwdriver. 

Removing the Top Cover 
Using a No. 2 Philips head screwdriver, unscrew the three 6-32 Philips head screws attaching 
the top cover to the rear panel.  Slide the cover back until it is clear of the front panel, and then 
lift it off. 
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To re-install the top cover, set the cover on top of the chassis and slide the cover forward until 
its front pins engage the front panel.  Secure the cover to the rear of the chassis with the three 
6-32 screws. 

General Handling Precautions 

ESD Precautions 

 

Observe electrostatic discharge (ESD) precautions to avoid 
damaging static-sensitive components when handling any 
PC card or disk drive. 

 

• When the case of your server is open and its internal parts are exposed, do not 
touch any internal part without first grounding yourself to the chassis. 

• Always wear a ground strap or work on an ESD-protective mat. 

• DO NOT remove components from protective packaging until you are properly 
grounded. 

• Handle printed circuit boards by their edges or by the metal bracket. 

• Don’t touch any pin, contact, lead or component on the printed circuit boards. 

• Keep disk drives in their anti-static package until installed in the server. 
 

Mechanical Concerns 

• Be careful when installing I/O cards into your system.  Excessive force can damage 
the PC boards, cables or the motherboard. 

• Be sure each board is aligned with its slot in the mating connector before installing.  
Use care to not flex any PC boards. 

• Interface cable connectors must be mated carefully. Use care to not bend any of the 
pins.  The connectors provided are keyed to prevent upside-down insertion. 

• Interface cables are fragile and must not be pinched. Ensure that their dress does not 
restrict airflow from fans or heat sinks within the enclosure. 

• Prior to installation, keep disk drives stored in a foam-lined protective carton to 
protect them from physical damage. 
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Installing/Removing I/O Cards 
Follow the preceding instructions to remove the top cover.  The I/O cards are accessible from 
the top of the chassis.  Generally, I/O cards can be extracted or installed with a No. 2 Philips 
screwdriver.  Each I/O card is held in place by one or two 6-32 X ¼” pan head Phillips screws 
on the rear panel of the chassis. 

Video I/O Card 

Remove the 6-32 x ¼” pan head Phillips screw holding the video card to the rear panel.  
The video I/O card is also held by a support bracket near the front panel.  Remove the 6-32 x 
¼” pan head Phillips screw holding the bracket to the inside wall of the chassis. 

While supporting the riser card, gently pull the video card from the riser card.  When the 
video card is clear of the PCI riser connector, move the card toward the front of the Image 
Server until the video connectors are clear of the rear panel.  Lift the video card from the 
chassis.  Unplug the 50-pin ribbon cable from the video card.  Immediately place the video 
card into a conductive storage bag to protect it from electrostatic discharges. 

Reverse the procedure to install a card.  After all the screws are reinstalled, check that the 
riser card, RAID card and video card are all seated properly in their PCI connectors. 

RAID Controller Card 

Unplug the four Serial-ATA cables from the RAID card.   

Remove the 6-32 x ¼” pan head Phillips screw holding the RAID card to the rear panel.  
Gently pull the card from its slot. Immediately place it in a conductive storage bag for 
protection from electrostatic discharge that can damage it. 

Reverse the procedure to install a card.  Be certain to install the Serial ATA cables into the 
correct RAID card connectors.  The cables are marked with connector numbers to match the 
numbers appearing next to each RAID card connector.  If these cables are connected in the 
wrong order, the data in the RAID array will be destroyed. 

Accessing the Motherboard 
There are no user-configurable options to set on the main system board.  If you suspect that the 
system board is not operating properly, consult with 360 Systems before proceeding.  DO NOT 
undertake any repairs on the motherboard. 
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Audio Level Calibration 
The input gain and output gain of the analog audio circuits are factory calibrated to a +4 dBu 
standard.  Each circuit includes a trim pot with a range of approximately ±2.5 dB.  The following 
procedures may be used to calibrate these for unity gain.  Each trim pot is located above the XLR 
connector with which it is associated.  Refer to the preceding drawing (Figure 27) for the location 
of trim pots and jumper blocks referred to in the calibration procedures. 

Calibration Procedure 
This procedure assumes that the technician is fully familiar with test procedures employing the 
Audio Precision® test equipment, or its equivalent. 

1. Position the jumper block J5 and J6 for Channel 1 output to obtain an analog output. 

2. Play the test clip titled zTONE present on the Image Server disk.  This stereo clip is 
recorded at a level equivalent to a +4 dBu output level. 

3. While observing the output level of audio Channel 1 Left, adjust trimmer RV4 until a level 
of exactly +4.00 dBu is obtained. 

4. Repeat this procedure for audio Channel 1 Right, while adjusting trimmer RV3, and also for 
each subsequent audio channel using its associated trim pot. 

Having established accurate gain settings for all analog audio outputs in steps 1 through 3 
above, calibrate the Image Server’s input gain as follows: 

5. Using the graphic user interface, place server Channel 1 in the E-E mode, so that an input 
signal will appear at its output. 

6. While observing the output level of audio Channel 1-L, apply a 1 KHz sine wave from the 
audio generator to audio Input 1-L.* 

7. Adjust input trimmer RV2 until a level of exactly +4.00 dBu is obtained at the output of 
Channel 1L. 

8. Repeat this procedure for audio Input 1-R, making the gain adjustment with input trimmer 
RV1. 

The preceding steps establish a gain of unity through the server. 

* In the absence of a generator, use the calibrated outputs of Channel 2 playing zTONE to 
feed the inputs. 
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Alternate Calibration Procedure 
If the calibration test clip titled zTONE is not found on the Image Server’s disk, it is still 
possible to accurately calibrate the audio channels. 

1. Position the jumper block J5 and J6 for Channel 1 output to obtain a digital output. 

2. Using the On-Screen graphic user interface, place server Channel 1 in the E-E 
mode, so that an input signal will appear at its output. 

3. Use the audio generator to apply a 1 KHz sine wave at a level of +4 dBu to analog 
audio Input 1-L. 

4. While observing the digital output level of audio Channel 1-L, adjust input gain trim 
pot RV2 until a level of –20 dBFs is obtained. (+4 dBu is 20 dB below full scale, 
which is +24 dBu; therefore it reads 20 dB below full scale or Fs.) 

5. Repeat steps 2 through 4 for analog audio Input 1-R, while adjusting input gain trim 
pot RV1. 

The server’s input gain is now calibrated.  It remains to calibrate each analog output for unity 
gain using the following procedure: 

6. Position all audio output jumper blocks to obtain analog outputs. 

7. Using the graphic user interface, verify that server Channel 1 is in E-E mode, so that 
an input signal will appear at its output. 

8. Apply a 1 KHz sine wave at a level of +4 dBu to analog audio Input 1-L. 

9. While observing the output level of audio Channel 1-L, adjust output gain trim pot 
RV4 until a level of +4 dBu is obtained. 

10. While observing the output level of audio Channel 1-R, adjust output gain trim pot 
RV3 until a level of +4 dBu is obtained. 

11. Make a 1-minute clip of the 1 KHz sine wave at a level of +4.00 dBu. Save this clip 
for future use in calibrating the server. 

12. Play this clip from Channel 2 and repeat steps 9 and 10 to adjust the gain of the left 
and right outputs. 

13. Play the clip created in step 11 from Channel 3 and repeat steps 9 and 10 to adjust 
the gain of the left and right outputs. 

The server’s output gains are now calibrated, and the entire sequence of the preceding steps 
have established a gain of unity through the server. 

Another method is to use digital input with a digital sine wave of –20dBFS to calibrate analog 
outputs 1 & 2 and create the reference clip. 



 

Page 112 MAXX Owner’s Manual 

Program Updates via CD-ROM 
Program updates are issued by 360 Systems from time to time.  The Image Server’s operating 
system and application programs can be updated by the user from new CD-ROMs, using the 
internal CD-ROM drive.  The current software version may be determined by looking in the GUI 
Help>About dialog. 

To install a program update, follow these instructions.  Please read them completely before 
beginning. 

1. Remove the Image Server front panel.  The internal CD-ROM drive is located on the left 
side. 

2. With power applied, press the CD eject button on the drive.  The drawer will open a 
short distance.  Gently pull the drawer open and insert the CD-ROM disk, printed side 
up.  Push the drawer closed until it latches. 

3. Press the front panel power switch briefly to shutdown the Image Server. 

4. Wait 5 seconds, then press the front panel power switch again to boot from the CD. 

5. The Installer menu provides a choice to Update the Image Server operating system, 
begin a new complete install, or cancel the install. 

• Choose UPDATE if you want to keep the video and audio clip files that exist on 
the Image Server.  Use this selection for all normal software updates. 

• Choose NEW only if you want to partition and reformat the drive array, and 
install the new operating system. 
 
IMPORTANT!  Using the NEW option will destroy all video and audio files on 
the Image Server.  For normal software upgrades, use the UPDATE option 
instead of NEW. 

6. The message, “Please wait while Image Server is being installed” will appear with an 
activity indicator.  When installation is complete, the server will automatically reboot 
from its hard disk array, and will display a copyright notice while starting up. It will also 
release the CD drawer. Remove the CD.  Never leave it in the CD drive. 

7. Replace the front panel.  Tighten the two large front panel access screws. 

If a disk cannot be ejected because the system is not responding or is powered off, the CD-ROM 
drawer can be released by inserting a paper clip into the small hole on the front of the drive. 
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Replacing a Hard Drive 
Generally, the only time that a hard drive should be removed from the disk array is when the drive 
array diagnostic software identifies a permanent fault.  In this case the front panel DRIVESDRIVESDRIVESDRIVES LED will 
blink.  Use the hard disk management tools to verify that a drive is at fault.  The application 
monitors many things about the array and individual drives, and will clearly indicate whether a 
drive has failed. 

Each hard drive bay is numbered 0 through 3, as are the drives.  If for any reason one or more 
drives have been removed, they must be reinstalled in a bay whose number matches the drive.  
Installation in the wrong location will damage data stored on all drives. 

1. Turn system power OFF with the front panel button.  After it has shut down, turn off the AC 
power switch and unplug the AC power cord. 

2. Remove the front panel as described above. 

3. Unscrew the holding plate from the front of the drive sub-chassis. 

4. Disconnect the power and Serial ATA data cable from the drive, and remove it from the 
drive bay. 

5. Replace the drive, fasten the holding plate in place, and reattach drive cables.  Note that 
the data cables are numbered; re-attach then to the same drive location from which they 
were removed. 

6. Replace the front panel and tighten the two large screws. 

7. Replace the AC power cord and turn on the rear panel AC switch. 

8. Turn the system ON using the front panel button and check the RAID array status. 

9. Check for correct operation of the server. 

NOTE: All drives in the RAID array should be identical. 

Factory Repair Policy  
A video server being returned under warranty shall be sent to 360 Systems, freight prepaid, in the 
original or equivalent packaging.  Call 360 Systems for a return authorization number before 
returning a product.  Have your serial number and software version number available for reference. 

Use the following address for shipping and correspondence.  360 Systems’ offices are open 
Monday through Friday, from 8:30 AM to 5:00 PM, Pacific Time. 

 
360 Systems  Telephone (818) 991-0360 
Customer Service Dept. Fax (818) 991-1360 
31355 Agoura Road E-mail info@360systems.com 
Westlake Village, CA  91361 Website www.360systems.com 
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Regulatory Certifications 

Safety 
The Image Server was tested by Underwriters Laboratories and found to comply with the 
following safety standards: 

EN 60950, 3rd Edition, dated December 1, 2000, Standard for Safety of Information 
Technology Equipment, Including Electrical Business Equipment. 

Laser Compliance 
The CD-ROM device used in this product is a Class 1 certified laser product.  Operating this 
product outside specifications or altering its original design may result in hazardous radiation 
exposure, and may be considered an act of modifying or new manufacturing of a laser 
product under U.S. regulations contained in 21 CFR Chapter 1, subchapter J or CENELEC 
regulations in HD 482 S1.  People performing such an act are required by law to re-certify 
and re-identify this product in accordance with provisions of 21 CFR subchapter J or 
distribution within the USA, and in accordance with CENELEC HD 482 S1 for distribution 
within countries using the IEC 825 standard. 

Laser Safety 
Laser safety in the United States is regulated by the Center for Devices and Radiological 
Health (CDRH).  The laser safety regulations are published in the “Laser Product 
Performance Standard,” Code of Federal Regulation (CFR), Title 21, Subchapter J. 

The International Electrotechnical Commission (IEC) Standard 825, “Radiation of Laser 
Products, Equipment Classification, Requirements and User’s Guide,” governs laser products 
outside the United States.  Europe and member nations of the European Free Trade 
Association fall under the jurisdiction of the Comité Européen de Normalization 
Electrotechnique (CENELEC). 

Radio Interference Compliance 

Radio Interference (USA) 

WARNING: This equipment has been tested and found to comply with the limits for Class A 
digital device pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment.  This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction's manual, may cause 
interference to radio communications.  Operation of this equipment in a residential area is 
likely to cause interference in which case the user will be required to correct the interference 
at his own expense. 

The user is cautioned that changes and modifications made to the equipment without 
approval of the manufacturer could void the user's authority to operate this equipment. 

It is suggested that the user use only shielded and grounded cables to ensure compliance 
with FCC Rules. 
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FCC Emission Limits 

This device complies with Part 15 of the FCC Rules.  Operation is subject to the following 
two conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesirable 
operation. 

Radio Interference (Canada) 

English: This Class A digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations. 

Français: Cet appariel numérique de la classe A respecte toute les exigences du Reglement 
sur le matériel brouilleur du Canada 



 

Page 116 MAXX Owner’s Manual 

Product Warranty 
 

Limited Warranty  

This product is warranted to the original purchaser against defects in material and workmanship for 
a period of one year from the date of original purchase.  This warranty covers parts and labor and is 
effective when the product is used without alteration for the purpose intended by 360 Systems.  
This warranty excludes products with modified or unauthorized software, that have been subject to 
misuse or neglect, that have been modified, repaired improperly or by unauthorized personnel, 
damaged by rough handling, abuse, improper operation, excessive temperature, lightning strike, 
static electricity, electrical surges or other electrical system malfunctions, improper or inadequate 
maintenance or care and that have been subject to use of unauthorized or non-conforming 
accessories or attachments.  This warranty also excludes normal wear and deterioration occasioned 
by the use of the product. 

If part of the product is defective, the entire product must be returned along with the original 
purchase receipt or other evidence of purchase and a description of the defect to 360 Systems, 
31355 Agoura Road, Westlake Village, California 91361.  Upon receipt, its condition will be 
verified, and if the product qualifies for warranty coverage, 360 Systems will, at its option, repair or 
replace the product without charge.  In the case of replacement, if the replacement for a defective 
product is no longer available, 360 Systems will replace it with a similar product or, if not 
available, a product of equal value. 
Disclaimer and Limitation of Liability 

The liability of 360 Systems under the foregoing warranty is limited solely to the repair or 
replacement of defective material or workmanship and does not include any expense related to the 
shipment of the product to or from 360 Systems or compensation for any inconvenience or loss of 
use of the product while it is being repaired or replaced. 
Except as expressly stated herein, 360 Systems makes no representations or warranties, either 
express or implied, of any kind with respect to the product.  EXCEPT AS EXPRESSLY STATED 
HEREIN, 360 SYSTEMS EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, OF 
ANY KIND WITH RESPECT TO THE PRODUCT, INCLUDING WITHOUT LIMITATION 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.   
360 SYSTEMS’ SOLE LIABILITY UNDER THIS LIMITED WARRANTY SHALL BE THE REPAIR OR 
REPLACEMENT OF ANY DEFECTIVE PRODUCT OR ITS COMPONENTS DURING THE 
WARRANTY PERIOD.  IN NO EVENT SHALL 360 SYSTEMS, ITS DIRECTORS, OFFICERS, 
EMPLOYEES OR REPRESENTATIVES BE LIABLE FOR DIRECT, CONSEQUENTIAL, PUNITIVE, 
SPECIAL OR INDIRECT DAMAGES, LOSS OF PROFITS, INCONVENIENCE OR ANY OTHER 
LOSSES DUE TO THE PRODUCT OR ITS OPERATION, DUE TO ITS FAILURE TO OPERATE IN 
ACCORDANCE WITH ITS SPECIFICATIONS. 
Some states or regions do not allow the exclusion or limitation of incidental or consequential 
damages under certain circumstances, so the above limitations and exclusions may not apply to 
you.  This warranty gives you specific legal rights, and you may also have other rights which vary 
from state to state or region to region. 
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End User License Agreement 
For Image Server Software 
 
IMPORTANT 
THIS IS A LEGAL AGREEMENT BETWEEN YOU (“YOU”) AND 360 SYSTEMS® (“COMPANY”).  
COMPANY IS WILLING TO LICENSE THE IMAGE SERVER SOFTWARE TO YOU ONLY UPON 
THE CONDITION THAT YOU ACCEPT ALL OF THE TERMS CONTAINED IN THIS SOFTWARE 
LICENSE AGREEMENT (“AGREEMENT”).  PLEASE READ THE TERMS CAREFULLY BEFORE 
OPENING THIS PACKAGE, OR IF DOWNLOADED, BEFORE INSTALLING THE SOFTWARE, AS 
OPENING THE PACKAGE, OR IN THE CASE OF DOWNLOADED SOFTWARE, INSTALLING IT, 
WILL INDICATE YOUR ASSENT TO THEM.  IF YOU DO NOT AGREE TO THE LICENSE TERMS, 
THEN COMPANY IS UNWILLING TO LICENSE THE SOFTWARE TO YOU, IN WHICH EVENT 
YOU MAY RETURN THE UNOPENED SOFTWARE PACKAGE TO THE PLACE FROM WHICH IT 
WAS ACQUIRED WITHIN 14 DAYS OF THE DATE OF PURCHASE AND YOUR MONEY WILL 
BE REFUNDED.  IF YOU ARE VIEWING THIS AGREEMENT ELECTRONICALLY, SELECT THE 
“ACCEPT” BUTTON AT THE BOTTOM OF THIS PAGE TO INDICATE YOUR ACCEPTANCE OF 
THE TERMS OF THIS AGREEMENT.  IF YOU ARE NOT WILLING TO BE BOUND BY ITS TERMS, 
SELECT THE “DECLINE” BUTTON AT THE BOTTOM OF THIS PAGE AND THE REGISTRATION 
OR INSTALLATION PROCESS WILL NOT CONTINUE. 
 
1. Company grants to You a non-exclusive license to use the Image Server software program (the 

“Software”) and any accompanying documentation (“Documentation”) solely for your internal business 
needs pursuant the terms and conditions of this Agreement.  The license to use the Software is 
conditioned upon Your compliance with the terms of this Agreement.  You shall be solely responsible 
for installation of the Software. 
 
Your use of the Software is limited to the licensing option set forth on your invoice.  Each licensing 
option is defined as follows: 
 
Single User License.  Software provided to You under this option may only be installed on any Image 
Server owned or controlled by You, but in no event may it be used on more than one Image Server at the 
same time. 
 
Multiple User License.  Software provided under this option may be installed on more than one Image 
Server owned or controlled by You, the maximum number of which is indicated on the purchase invoice 
for this Software. 
 

2. You may not transfer the Software to another entity or person.  Any such transfer terminates your license 
under this Agreement.  You shall not modify, translate, reverse assemble or reverse compile in whole or 
in part the Software that is provided in object code.  You may not rent, sell, time-share, lease, sublicense, 
transfer, publish, disclose, display, or otherwise make available the object code or copies thereof to 
others.  You may not make copies of the object code except as provided herein.  You shall not tamper 
with, bypass or alter any security features of the Software or attempt to do so. 
 

3. This license is not a sale.  Title, ownership rights, and intellectual property rights in and to the Software 
and Documentation shall remain with the Company.  You agree to abide by the copyright laws and all 
other applicable laws of the United States, your country, and international law.  You acknowledge that 
the Software design remains a confidential trade secret of Company.  Failure to comply with the above 
restrictions will result in automatic termination of this license and will make available to Company other 
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legal remedies.  You may not disclose any of Company’s proprietary or trade secret information relating 
to the Software to any third party. 
 

4. Company warrants that the Software will perform substantially in accordance with its Documentation.  
Your exclusive remedy for breach of this limited warranty and Company’s entire liability shall be, in 
Company’s discretion, either return of the price paid to Company by You for the Software, or repair or 
replacement of the Software after Software and Documentation are returned to Company with an 
applicable receipt.  Company’s warranty is void if failure of the Software has resulted from accident, 
abuse, modification or misapplication.  COMPANY MAKES NO OTHER WARRANTIES, EXPRESS OR 
IMPLIED, WITH RESPECT TO THE SOFTWARE AND DOCUMENTATION, AND SPECIFICALLY 
DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE.  COMPANY DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR FREE. 
 

5. TO THE MAXIMUM EXTENT PERMITTED BY LAW, IN NO EVENT SHALL COMPANY BE LIABLE FOR 
ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL OR PUNITIVE DAMAGES WHATSOEVER, 
INCLUDING ANY CLAIMS FOR LOST PROFITS, BUSINESS INTERRUPTION, LOST INFORMATION 
OR OTHER DAMAGES ARISING OUT OF THE USE OR INABILITY TO USE THE SOFTWARE.  IN ALL 
EVENTS, COMPANY’S SOLE OBLIGATION OR LIABILITY UNDER THIS LICENSE IS THE 
REPLACEMENT OR REPAIR OF THE SOFTWARE OR A REFUND OF THE PURCHASE PRICE. 
 

6. You may terminate the license granted in Section 1 of this Agreement at any time by destroying or 
erasing your copy of the Software.  Company may terminate this Agreement immediately and without 
notice if you fail to comply with any term or condition of this Agreement.  In the event of termination of 
this Agreement, all the sections of this Agreement will survive except for Section 1. 
 

7. This Agreement shall be governed by and construed in accordance with the laws of the State of 
California, U.S.A., without reference to conflicts of laws provisions or the 1980 U. N. Convention on 
Contracts for the International Sale of Goods and, as to matters affecting copyrights, trademarks and 
patents, by U.S. federal law.  Any dispute with respect to this Agreement shall be brought and heard 
either in the California state courts located in Los Angeles County, California, or the federal district court 
for the Central District, Western Division, located in Los Angeles, California.  In such event, the parties 
to this Agreement each consent to the in personam jurisdiction and venue of such courts.  The parties 
agree that service of process upon them in any such action may be made if delivered in person, by 
courier service, by telegram, by facsimile or by first class mail, and shall be deemed effectively given 
upon receipt. 
 

8. This Agreement sets forth the entire agreement between You and Company pertaining to the licensing of 
the Software, and supersedes in its entirety any and all written or oral agreements previously existing 
between the parties with respect to such subject matter.  If any provision of this Agreement is held 
invalid or unenforceable, such provision shall be revised to the extent necessary to cure the invalidity or 
unenforceability, and the remainder of this Agreement shall continue in full force and effect.  In the 
event of any conflict between any provision of this Agreement and applicable law, the provisions of this 
Agreement affected shall be modified to remove such conflict and permit compliance with such law, and 
as so modified this Agreement shall continue in full force and effect.  This Agreement may not be 
assigned without the consent of Company. 
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Appendix A 

Connector Specifications 
 

Audio XLR-3 Connector Pinout 
Signals appearing on the XLR connectors are determined by the setting of the internal 
Analog/Digital Audio Selection jumpers. 

 

Pin BALANCED ANALOG AES/EBU DIGITAL 

1 SHIELD (FRAME GROUND) SHIELD (FRAME GROUND) 

2 " + " OR HOT DIGITAL + 

3 " – " OR COMMON DIGITAL - 

SHELL FRAME GROUND FRAME GROUND 
  

Serial Control Connector Pinout 
 

Pin 
EIA-422, DB9-F 
Connector 

1 GND 

2 Transmit A (TX–) 

3 Receive B (RX+) 

4 GND 

5 N/C 

6 GND 

7 Transmit B (TX+) 

8 Receive A (RX-) 

9 GND 

Shell Frame ground 
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BNC Connectors 
The following note applies to all video, LTC, and Genlock connectors: 

• A BNC connector used as an output will have 75-ohm source impedance. 
• A BNC connector used as an input will have a fixed 75-ohm termination. 

 
GPI Connector 

General purpose control inputs (GPI) may be applied to the GPI port, which is a DB-25-F 
connector.  These inputs are optically isolated from the Image Server circuitry; individual 
floating returns are provided.  +5 volts may be sourced from pins 21 or 22, or provided from 
an external source.  Current limiting devices are provided within the Image Server. 

General purpose status outputs also appear on the GPI connector.  Open-collector outputs are 
provided as status outputs, and may be used to drive an external LED or control input. 

Refer to the connector pin-out table and partial schematic, following. 

GPI Connector Pinout 
 

Pin Signal Pin Signal 

1 GPI 1 14 GPI 1 RTN 

2 GPI 2 15 GPI 2 RTN 

3 GPI 3 16 GPI 3 RTN 

4 GPI 4 17 GPI 4 RTN 

5 GPI 5 18 GPI 5 RTN 

6 GPI 6 19 GPI 6 RTN 

7 N/C 20 N/C 

8, 9, 10 GND 21, 22 +5V SOURCE (200MA MAX) 

11 GPO 2 23 GPO 1 

12 GPO 4 24 GPO 3 

13 GPO 6 25 GPO 5 
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1GPI 1

GPI 1 RTN

9SIGNAL GND

14

10

13GPO 6

25GPO 5

12GPO 4

24GPO 3
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19
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GPO 1 23
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GPI 2
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GPI 3
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GPI 4
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GPI 6 RTN

GPI 6

21

8

 

Figure 31: GPI Connection Schematic 
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System Board Ports 
Standard computer I/O ports on the Image Server include video monitor, keyboard, mouse, and 
Gigabit Ethernet ports. Pinouts are provided to assist in wiring or trouble-shooting. 

Keyboard and Mouse 

Keyboard and mouse ports are provided on the rear panel.  Both ports are provided with a 
resettable fuse protecting the +5V supply to the peripheral. 

SVGA Ports  

A VGA or SVGA computer monitor may be connected to the 15-pin video port.  The Image 
Server is pre-configured to an SVGA screen resolution of 1024 x 768 and 64,000 colors.  
The refresh rate will auto-negotiate with the attached monitor to achieve the best available 
value.  This resolution is best viewed on 17-inch or larger monitors.  Use only VESA 
compliant monitors.  360 Systems does not provide monitors for the server. 

SVGA Connector Pinout 

Pin Signal Pin Signal 

1 RED 9 +5V 

2 GREEN 10 GND 

3 BLUE 11 RESERVED* 

4 RESERVED* 12 SDA 

5 GND 13 HSYNC 

6 RED RTN 14 VSYNC 

7 GREEN RTN 15 SCL 

8 BLUE RTN SHELL FRAME GROUND 

  * Pulled high to +5V. 

Unused Ports  

USB ports and an RS-232 serial port are present on the Image Server.  These are not active 
and no connection should be made to them. 
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Appendix B 

Serial Command Protocols 

VDCP Command Table 
The Image Server responds to the following VDCP commands.  Shaded areas indicate commands 
slated for future implementation. 

COMMAND FROM CONTROLLER RETURN FROM CONTROLLED DISK 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

0X / 8X 15 Delete Protect ID  04 ACK 

0X / 8X 16 Undelete Protect ID  04 ACK 

 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

1X 00 Stop  04 ACK 

1X 01 Play  04 ACK 

1X 02 Record  04 ACK 

1X 04 Still  04 ACK 

1X 05 Step  04 ACK 

1X 06 Continue  04 ACK 

1X 07 Jog  04 ACK 

1X 08 Varispeed Play  04 ACK 

1X 0A EE Mode  04 ACK 

 

CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

2X / AX 1D Rename ID  04 ACK 

2X 1E Preset Std. Time  04 ACK 

2X / AX 1F New Copy  04 ACK 

2X  20 Sort Mode  04 ACK 

2X  21 Close Port  04 ACK 

2X  22 Select Port  04 ACK 

2X / AX 23 Record Initialize  04 ACK 

2X / AX 24 Play Cue  04 ACK 

2X / AX 25 Cue with Data  04 ACK 

2X / AX 26 Delete ID  04 ACK 

2X / AX 2C Record Init with Data  04 ACK 

2X  30 Preset  04 ACK 
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CMD-1 CMD-2 NAME CMD-1 CMD-2 NAME 

3X  01 Open Port 3X 81 Grant/Denied 

3X / BX 02 Next 3X 82 List of ID's 

3X  05 Port Status Request 3X 85 State Status 

3X  06 Position Request 3X 86 Position 

3X / BX 07 Active ID Request 3X 87 Active ID 

3X  08 Device Type Req. 3X 88 Device Type 

3X  10 Syst. Status Request 3X 90 System Status 

3X / BX 11 ID List 3X 91 List of ID's 

3X / BX 14 ID Size Request 3X 94 ID Size 

3X / BX 16 ID Request 3X 96 ID Presence 

3X  17 Compression Settings 
Request 

3X 97 Compression Settings 

3X / BX 18 ID's Added List 3X 98 List ID's Added 

3X / BX 19 ID's Deleted List 3X 99 List ID's Deleted 
 
AX and BX versions are long-filename variants. 
Macro commands (5X/DX in CMD-1) are not implemented. 
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P2 Serial Command Table  
The Image Server command set includes most commands used in BVW tape machines. Commands 
not implemented include those for DMC operations, audio split and in/out points, and those 
specifically related to tape as a medium.  

The server will return Device Type response 20.25 for BVW-75 (NTSC); 21.25 for BVW-75 (PAL). 

COMMAND DESCRIPTION RETURN COMMENT 

00.11 DEVICE TYPE REQUEST ACK  

00.1D LOCAL ENABLE ACK  

00.0C LOCAL DISABLE ACK  

20.00 STOP ACK  

20.01 PLAY  ACK  

20.02 RECORD ACK  

20.10 FAST FORWARD ACK  

2X.11 JOG FORWARD ACK  

2X.12 VAR FORWARD ACK  

2X.13 SHUTTLE FORWARD ACK  

20.20 REWIND ACK  

2X.21 JOG REVERSE ACK  

2X.22 VAR REVERSE  ACK  

2X.23 SHUTTLE REVERSE ACK  

20.30 PRE-ROLL ACK  

20.0F EJECT ACK  

20.05 STANDBY ON ACK  

20.60 FULL E-E OFF ACK   

20.61 FULL E-E ON ACK  

24.31 CUE UP WITH DATA ACK  

40.08 TIMER 1 RESET ACK  

40.10 IN ENTRY ACK  

40.11 OUT ENTRY ACK  

40.18 IN SHIFT + ACK  

40.19 IN SHIFT - ACK  

40.1A OUT SHIFT + ACK  

40.1B OUT SHIFT - ACK  

40.2D LOST LOCK RESET ACK   

41.36 TIMER MODE SELECT ACK  

41.37 INPUT CHECK ACK  

44.00 TIMER 1 PRESET ACK  

44.04 TIME CODE PRESET ACK  

44.31 PRE-ROLL TIME PRESET ACK   

41.33 SERVO REFERENCE SELECT ACK   

N/A TIMER MODE STATUS ACK  

7X.20 STATUS DATA 7X.20  

N/A COMMAND SPEED SENSE 71.2E  

40.48 REF VIDEO SELECT ON ACK   

40.49 REF VIDEO SELECT OFF ACK   

6X.0E CURRENT TIME SENSE  ACK  

ACK= 10.01  NAK=11.12.xx 
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Odetics® Protocol 
Odetics serial protocol is an extension of Sony P2 tape machine control protocol.  Among its 
most significant features is the selection of a file by name rather than by time-code location, as 
with P2.  Odetics protocol is used by many table-top controllers, and some automation 
systems.   

Note that the Odetics protocol only supports clip names up to 8 characters.  Longer clip 
names are automatically filtered out from responses by the server. 

ACK = 0X1001 

COMMAND DESCRIPTION RETURN COMMENT 

0X1001    

0X000C   LOCAL DISABLE  ACK  

0X0011   DEVICE TYPE 0X1211 BVW-75 

0X001D   LOCAL ENABLE ACK  

0X2000   STOP ACK  

0X2001   PLAY ACK  

0X2002   RECORD ACK  

0X2004   STAND BY OFF ACK  

0X2005   STAND BY ON ACK  

0X200D   DMC START ACK COMMAND HAS NO EFFECT 

0X200F   EJECT ACK  

0X2010   FAST FORWARD ACK  

0X2X11   JOG FORWARD ACK  

0X2X12   VAR FORWARD ACK  

0X2X13   SHUTTLE FORWARD ACK  

0X2020   REWIND ACK  

0X2X21   JOG REVERSE ACK  

0X2X22   VAR REVERSE ACK  

0X2X23   SHUTTLE REVERSE ACK  

0X2030   PREROLL ACK  

0X2X31   CUE UP ACK  

0X2X38   PROG SPEED PLAY PLUS ACK  

0X2X39   PROG SPEED PLAY MINUS ACK  

0X2052 TENSION RELEASE ACK COMMAND HAS NO EFFECT 

0X2054   ANTI CLOG TIMER DISABLE ACK COMMAND HAS NO EFFECT 

0X2055   ANTI CLOG TIMER ENABLE ACK COMMAND HAS NO EFFECT 

0X2X5C   DMC SET FORWARD ACK COMMAND HAS NO EFFECT 

0X2X5D   DMC SET REVERSE ACK COMMAND HAS NO EFFECT 

0X2060   FULL EE OFF ACK  
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0X2061   FULL EE ON ACK  

COMMAND DESCRIPTION RETURN COMMENT 

0X4X00   TIMER1 PRESET ACK  

0X4X04   TIME CODE PRESET ACK  

0X4008   TIMER1 RESET ACK  

0X4010   IN ENTRY ACK  

0X4011   OUT ENTRY ACK  

0X4X14   IN PRESET ACK  

0X4X15   OUT PRESET ACK  

0X4018   IN SHIFT PLUS ACK  

0X4019   IN SHIFT MINUS ACK  

0X401A   OUT SHIFT PLUS ACK  

0X401B   OUT SHIFT MINUS ACK  

0X4020   IN RESET ACK  

0X4021   OUT RESET ACK  

0X402D   LOST LOCK RESET ACK  

0X4X30   EDIT PRESET ACK COMMAND HAS NO EFFECT 

0X4X31   PRE-ROLL TIME PRESET ACK  

0X4X32   TAPE AUTO SELECT ACK  

0X4X33   SERVO REFERENCE SELECT ACK  

0X4X34   HEAD SELECT ACK COMMAND HAS NO EFFECT 

0X4X35   COLOR FRAME SELECT ACK COMMAND HAS NO EFFECT 

0X4X36   TIMER MODE SELECT ACK  

0X4X37   INPUT CHECK ACK  

0X4040   AUTO MODE OFF ACK  

0X4041   AUTO  MODE ON ACK  

0X4046   VARIABLE MEMORY OFF ACK  

0X4047   VARIABLE MEMORY ON ACK  

0X4048   VIDEO REFERENCE DISABLE OFF ACK COMMAND HAS NO EFFECT 

0X4049   VIDEO REFERENCE DISABLE ON ACK COMMAND HAS NO EFFECT 

0X4X70   VIDEO INPUT SELECT ACK  

0X4X91   OUTPUT VIDEO LEVEL ACK COMMAND HAS NO EFFECT  

0X4X92   OUTPUT SETUP BLACK LEVEL ACK COMMAND HAS NO EFFECT 

0X4X93   OUTPUT CHROMA LEVEL ACK COMMAND HAS NO EFFECT 

0X4X98   OUTPUT H PHASE ACK COMMAND HAS NO EFFECT 

0X4X99   OUTPUT SC PHASE ACK COMMAND HAS NO EFFECT 

0X4X9A   OUTPUT VIDEO HUE  ACK COMMAND HAS NO EFFECT 

0X6X0A   TC GEN DATA SENSE   
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                    GEN TIME DATA 0X7408  

COMMAND DESCRIPTION RETURN COMMENT 

      GEN UB DATA 0X7409  

      GEN U BAND TC DATA 0X7809  

0X600C   CURRENT TIME SENSE   

      CORRECTED LTC TIME DATA 0X7414  

      VITC TIME DATA 0X7406  

      TIMER1 DATA 0X7400  

      HOLD USER BITS LTC DATA 0X7415  

      HOLD USER BITS VITC DATA 0X7416  

0X6010   IN DATA 0X7410  

0X6011   OUT DATA 0X7411  

0X6012   A IN DATA NAK  

0X6013   A OUT DATA NAK  

0X6020   STATUS DATA 0X7420  

0X6X23   SIGNAL CONTROL DATA 0X7423  

0X602E   COMMAND SPEED DATA 0X712E  

0X602F   VAR MEM SPEED DATA 0X712F  

0X6X30  EDIT PRESET DATA NAK  

0X6031   PREROLL TIME DATA 0X7431  

0x6036   Timer Mode Status 0X7136  

0XA001  AUTO SKIP ACK ODETICS COMMAND 

0XAX02   CUE UP TO RECORD ACK ODETICS COMMAND 

0XAX04   PREVIEW IN PRESET ACK ODETICS COMMAND 

0XAX05   PREVIEW OUT PRESET ACK ODETICS COMMAND 

0XA006   PREVIEW IN RESET ACK ODETICS COMMAND 

0XA007   PREVIEW OUT RESET ACK ODETICS COMMAND 

0XAX10   ERASE ID ACK ODETICS COMMAND 

0XA014  LIST FIRST ID 0X8814 ODETICS COMMAND 

0XA015   LIST NEXT ID 0X8814 ODETICS COMMAND 

0XAX18   ID STATUS REQUEST 0X8818 ODETICS COMMAND 

0XA01C   MAXIMUM STORAGE LENGTH 0X891C ODETICS COMMAND 

0XAX20   SET DEVICE ID ACK ODETICS COMMAND 

0XA021   DEVICE ID REQUEST 0X8821 ODETICS COMMAND 

0XCX01     JUMP FORWARD X FRAMES ACK ODETICS COMMAND 

0XCX02     JUMP BACK X FRAMES ACK ODETICS COMMAND 

0XCX03     GET LOADED ID ACK ODETICS COMMAND 
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Appendix C 

Technical Specifications 

Video 

Input Channels (baseband) One 

Output Channels Three (3 playback or 1 record (E-E) and 2 playback)  

Analog video I/O Composite, 75 Ω, BNC 

Digital video I/O SDI, SMPTE 259M, 75 Ω BNC 

Video standards 525/60 NTSC; 625/50 PAL (Model dependent) 

MPEG recording formats MPEG-2: 4:2:2 Profile @ Main Level to 50 Mb/s 
MPEG-2: Main Profile @ Main Level to 15 Mb/s (4:2:0 or 4:1:1) 

DV playback format Playback of 25 Mb/sec DV files imported via Ethernet. 

Graphics playback format Playback of TARGA files with key & fill imported via Gigabit 
Ethernet. 

Word Size 10 bits dithered to 8 

Frame format I-frame, 6-GOP, 14 GOP 

Minimum pre-roll 10 frames 

Video sync reference (Genlock) External black burst or internal crystal 

Audio 

Digital Inputs/Outputs 2 stereo pairs (4 channels) per video input or output 

Digital audio format AES/EBU, 110-ohm, XLR-3 connector (AES-3-2000) 

Dynamic range (digital) 144 dB (24-bit word size) 

Audio format 48 KHz sample rate, 24-bit word size, Linear PCM 

Embedded audio 20-bit, 4-channel.  

Bit-for-Bit® data handling Transparent to Dolby®-E, Dolby AC-3 

Analog Inputs/Outputs 2 mono channels per video input or output 

Analog audio format Balanced, +4 dBu, XLR-3 connector 

Frequency response 10 Hz – 20 KHz ±0.1 dB 

Harmonic distortion <0.002% THD+N at full scale –1 dB 

Dynamic range 112 dB (24-bit word size) 

Headroom 20 dB above nominal +4 dBu operating level 

Audio sync reference Derived from video reference 

Time Code 

LTC In External time code, > 10 KΩ BNC connector 

LTC Out External time code, Z = 750 Ω, BNC connector 

VITC line number, NTSC Field 1: Lines 14, 16; Field 2: Lines 277, 279 

VITC line number, PAL Field 1: Lines 19, 21; Field 2: Lines 332, 334 
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Closed Captions 

Closed Captions Records and plays CC data per EIA-608B 

Control Inputs 

Automation control, RS-422 VDCP; 3 ports, 9-pin female “D” connector 

Other serial control, RS-422 P2, Odetics 

GPI control inputs/outputs 6 optically isolated inputs, 6 open-collector outputs, 25-pin 
female “D” connector 

Video Networking 

File interchange formats MXF (SMPTE 377M, 378M, 381M) OP-1a, OP-1b; MPEG-2 
program streams & elementary streams; DV stream (.dv or 
.avi); TARGA graphics import.  

Network port Gigabit Ethernet 

File transfer protocol FTP 

Disk Storage 

Storage time (max) 450 hours max at 12 Mb/s 

Capacity 1.0 TB to 4.0 TB 

Data redundancy Hardware-generated RAID-5 utilizing 4 drives 

Drive arrangement Located within enclosure, accessible behind front panel  

CD-ROM drive Internal, replaceable from front panel.  (For loading operating 
system and feature upgrades.) 

Miscellaneous 

Operating system Linux® 

Front panel indicators 5 LEDs indicate Power-on, Genlock, Fan alarm, Drive alarm, 
System alarm 

Miscellaneous ports Keyboard, mouse, SVGA display 

Cooling/Operating Temperature Forced air; Ambient operating temperature 10º to 35º C 

Power 100 – 240 VAC, 50/60 Hz, 2.0 amp max. Shut down switch on 
front panel; hard AC mains switch on rear panel 

Physical  

Mechanical  3½” x 19” x 18.5” (89 x 483 x 470 mm) H-W-D  

Mounting Rack mount (2U), optional adjustable rear supports 

Weight 28 lb. (12.7 Kg) 

Agency approvals UL, C-UL, FCC Class A, CE 

Country of origin U.S.A. 
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Keyboard Shortcuts 

Transport Control  Edit Operations 

L Forward at 4x, 16x, 64x, 128x  E Enter/Exit Edit Mode 

K Pause (Stop)  I Capture Mark In 

J Reverse at 4x, 16x, 64x, 128x  O Capture Mark Out 

Space Bar Play/Pause (toggle)  Shift+R Review Edit 

R Record  Shift+T Review Tail 

Home GoTo Head point   

End GoTo Tail point  Playlist 

Shift+E E/E Toggle  Home Recue 

Shift+L Loop Toggle  Space Play/Pause 

Shift+C Local Toggle  K Stop 

Shift+J Eject Clip   

Right Arrow Jog forward 1 frame  Playlist Edit 

Left Arrow Jog reverse 1 frame  Shift+C Clear 

   Left Arrow  << (Remove clip) 

File Operations  Right Arrow >> (Add clip) 

Ctrl+N New   

Ctrl+O Open  Navigating Between Channels 

Ctrl+S Save  Ctrl+<number> 
Switches to Transport 
Channel <number> 

Ctrl+A Save As  Alt+<number> 
Switches to Playlist  
Channel <number> 

Ctrl+D Delete   

Ctrl+R Rename  Mark In/Mark Out Times (Edit Mode) 

  <number> Inserts right justified number 

Menu Operations  DEL Removes last digit 

Alt+F Expands File Menu  ESC Aborts time code entry 

Alt+T Expands Transport Menu  .  ;  :  (any) Shifts time code left 

Alt+C Expands Configure Menu  TAB 
Toggles between Mark In  
and Mark Out times 

Alt+P Expands Playlist Menu    

Alt+W Expands Window Menu    

Alt+H Expands Help menu    
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APPENDIX D – PLAYLIST MANAGEMENT DETAIL 
Playlists can be accessed via the Image Server’s FTP feature, allowing several capabilities: 

• Lists can be backed up on a PC, and sent to another Image Server. 

• Lists can be viewed and printed from the PC 

• Lists can be edited or created on the PC and uploaded to the Image Server. 

Playlists are found on the Image Server FTP directory in the lists folder.  They are simple text 
files with the extension .lst.  Below is an example of a playlist as it appears in the GUI and its 
corresponding .lst file: 

 

 

 

#360PLAYLIST 2.0 

#StartTime 13000100 

#Loop 0 

 

"/Public Service Announcement" 

"/Adverts/Commercial" 

"<HOLD>", HOLD 

"/Sitcom",#1@0;10 

"/Movie of the Week",#2@15;1000,#6@1245000;400 

"/Documentary", SKIP 

"/Still Frame" 

"/Still Frame 2", frames=150 
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Each line of the example appears with its explanation below: 

#360PLAYLIST 2.0  

Header line, this must always be present exactly as shown. 

#StartTime 13000100 

This is the Start Time in military format, hours, minutes, seconds and frames, without leading 
zeros. This value shows 13:00:01 or 1 minute past 1 pm. The default is 0 which is 12 midnight.  
While frames are present in this value, the last two digits should always be “00” when entering 
any value except 0. 

#Loop 0 

This is the default, a looping list would show “#Loop 1”. 

"/Public Service Announcement" 

This is the first clip in the list, named Public Service Announcement.  It is enclosed in quotes, 
and preceded by a forward slash ( / ) which denotes that the clip is found in the root directory 
(i.e. it is not in a subfolder). 

"/Adverts/Commercial" 

This is the second clip, named Commercial.  It is in the Adverts subfolder.  Further levels of 
subfolder nesting would be shown as “/Folder/Subfolder/ClipName”. 

"<HOLD>", HOLD 

This is a Hold event.  The list will stop until it is restarted by command. 

"/Sitcom",#1@0;10 

This clip has a GPI Output event associated with it, in this case Output #1, at an offset of 1 
frame, for a duration of 10 frames.  Similar to Start Time values, GPI Output Offsets and 
Durations are represented as hours, minutes, seconds and frames without leading zeros. The 
format is: 

,#GPIOutputNumber@Offset;Duration 

"/Movie of the Week",#2@15;1000,#6@1245015;400 

This clip has two GPI Output events, Output #2 @ 15 frames offset ; 10 seconds duration, and 
#6@1 hour 24 minutes 50 seconds 15 frames offset; 4 seconds duration. 

"/Documentary", SKIP 

This clip is skipped, this is programmed in the GUI by unchecking the check box for the event. 

"/Still Frame" 

Still frames appear the same as standard motion clips; the name of this clip is Still Frame. 

"/Still Frame 2", frames=150 

This still frame has a duration programmed.  Unlike other time values, durations are frame 
counts. In NTSC this is a 5 second duration.  While it is possible to add a duration to a motion 
clip, this is not recommended.  It is only allowed to specify fewer frames than the edited length 
of the clip (Mark In to Mark Out).  You cannot make the clip “loop” by specifying a longer 
duration. 

When opening Playlist files in a text editor, you may have to change the file type to “All Files” 
to be able to see files with the .lst extension.  
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Some text editors, such as Notepad, do not display each line separately.  Word and Wordpad 
work correctly.  This is because the files have only Line Feeds (LF) at the ends of lines.  The 
Image Server will accept modified or externally created files with only LF or with both LF and 
Carriage Return (CR) at line endings.  You cannot use only CR without LF. 

You can edit the list by: 

• Changing the names of the clips. 

Clip names are case sensitive.  Any clip name that does not match an existing clip will be 
reported as MISSING when the list is loaded on the Image Server.  This also applies to the 
names of any subfolders. 

• Adding or deleting events manually. 

Any of the available event types can be created. 

• Modifying or adding to existing events. 

You can add “, SKIP” “, frames=xx” or GPI Outputs. 

• Cut and Paste the contents of one list into another, or duplicate sections of a list. 

 

Save the file as a raw text file, and replace the .txt extension with .lst.  File names should be 
limited to 31 characters. 

When transferring .lst files via FTP, always specify Binary mode.  Do not use ASCII or Auto. 
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APPENDIX E – AS-RUN LOGGING DETAIL 
To enable As-Run logs, open a Playlist window, select Options, then click on As-Run Logs.  
When enabled, a check mark will appear next to the As-Run log label, and files played by a 
playlist will be written to an As-Run log. Clips played in a transport window do not get written 
to an asrun log. 

As-Run logs are available only through FTP downloads; they cannot be viewed or printed from 
the Image Server itself.  After logging into the Image Server, select the ASRUN folder.  All logs 
are stored in this location, and have the extension “.arl”. 

As-Run Naming Convention 

The Naming convention for as-Run logs is as follows:  mmdd.c_xxxx.n.arl 

mm   month ( 01 through 12 ) 
dd     Day     ( 01 through 31 ) 
c      Channel ( 1 through 3 ) 
xxxx  Name of Playlist 
n Instance Count 
arl file extension 

Sample As-Run Log 

IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2005 [Wednesday PM]          Pg 1 

   1  10:54:40   00:00:05:00   KRBE ID - Legal          PLAYED OK 
   2  10:54:45   00:00:30:00   Cellular One – Talk Time     PLAYED OK 
   3  10:55:15   00:00:30:00   Burger Stop – 2 for 1           PLAYED OK 
   4  10:55:45   00:00:15:00   Promo – Friends - Today   PLAYED OK 
   5  10:56:00   00:00:30:00   Bank of America – Gold Years      PLAYED OK 
   6  10:56:30   00:07:18:05   RICKI WEDNESDAY – SEG 1      PLAYED OK 
 
Periodically, old logs should be deleted using the Delete command on your FTP client 
software. 

As-Run Log Page Header 

This section describes the format of the first line (page header): 

IS-76152 as-run (Ch2:KQRS) Engr Wed Feb 02, 2005 [Wednesday PM]          Pg 1 

IS-76152:  IS-XXXXX, where XXXXX is the unique machine ID as shown in Help>About>Unit ID. 

as-run (Ch2:KQRS):  ChX is the channel number and KQRS is the name of the specific channel, as 
defined in the Configuration System window. 

Engr:  The name of the Image Server, as defined in the Configuration System window. 

Wed Mar 30, 2005:  The base date to which clip times are referenced. 

[Wednesday PM]:  The name of the playlist 

Pg 1:  The page number of the printout.  
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As-Run Log Body 

This section describes the format of the body of an As-Run log: 
2  10:54:45   00:00:30:00   Cellular One – Talk Time      PLAYED OK 

 
2:  The line number (order) of the clip as it appears in the playlist. The same clip could have 

multiple numbers as files are added or deleted. 

10:54:45  The time at which the clip was played in HH:MM:SS, on a 24-hour clock. 

00:00:30:00  The length of the clip in HH:MM:SS.FF, on a 24-hour clock. 

Cellular One – Talk Time:  The name of the clip. 

PLAYED OK:  The status of the played clip.   

 

 

Other possible status conditions are: 

CLIPPED - Less than the full length played.  

SKIPPED – The clip was skipped over because it was deselected (unchecked) or playback was 
order was modified by CUE or JUMP 

STOPPED – The clip was stopped during playout.   
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APPENDIX M – IMPORTING MPEG 
PROGRAM STREAM FILES 

Encoding MPEG-2 Files Compatible with Image Server  

360 Systems recommends the use of the Main Concept MPEG Encoder.  It is available as a stand 
alone product as well as integrated into codecs bundled with various video editing programs.   
 
MPEG video encoding is a highly complex and variable system, designed to accommodate many 
different applications. It is very important to note that not all MPEG program stream files are 
compatible with the decoder in the Image Server.  Before deploying a system that depends on 
material from external encoders, it is critical to observe the following: 
 

• Decide on a bit rate and GOP structure that will suit your needs.  If necessary, perform 
tests with various types of program material that will be presented.  Be sure to include 
graphics and scenes with representative detail, motion characteristics and audio. 

• Once you have a standard format selected, perform tests with the material on the Image 
Server running a representative broadcast day, with a wider selection of different clips.  
Use the same workflow to create and transfer the content as will be used in actual 
operation. 

• In the event that you must accept material from different sources (especially if that 
means different editing platforms or video formats) be sure to run tests that demonstrate 
compatibility between them.  Inspect the quality of transitions carefully. 

 

Once you have determined your processes and workflow, it is important ensure that they remain 
unchanged.  Seemingly minor changes can have serious negative effects on playback quality, or 
even interrupt a broadcast. 

 

360 Systems does not guarantee the performance of the Image Server with all possible forms of 
externally encoded material.  It is the responsibility of the user to qualify this material and actually 
test it to ensure that it is compatible. 
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General Requirements 
 

FILE NAMES 31 characters or less followed by the “.mpg” extension. 
Upper/Lower case alpha, 0-9, #%&()-_ 

STREAM TYPE: PROGRAM (VIDEO + AUDIO) 
VIDEO RESOLUTION: 720x480 (NTSC) or 720x576 (PAL)     4:3 DISPLAY 
FRAME RATE: 29.97 (NTSC) or 25 (PAL)    (Pulldown is not supported.) 
FIELD ORDER: INTERLACED, TOP FIELD FIRST  (See note below.) 
BITRATE TYPE: VARIABLE 
BITRATE RANGE: Recommended range 5 to 30 Mb/s.  

Minimum 2 Mb/s, maximum 50 Mb/s 
GOP STRUCTURE: Closed GOP (Open GOP architecture is not supported) 

Recommended values 1 (I frame) 6 (IBPBPB)  or 15 
PROFILE: MAIN or 4:2:2 
LEVEL: MAIN  
CHROMINANCE FORMAT: 4:2:2 or 4:2:0 
SEQUENCE HEADERS: REQUIRED – 1 per GOP 
 
Recommended combinations of Bit Rate, GOP size and Profile (Chrominance format): 
 25 Mb/s, I frame only, 4:2:2 – high quality, for contribution content 
 15 Mb/s, I frame only, Main (4:2:0) – good quality, frame accurate editing 
 12 Mb/s, 6 frame GOP, Main (4:2:0) – good quality, efficient storage. 
 8 Mb/s, 15 frame GOP, Main (4:2:0) – highest storage efficiency. 
 
 
AUDIO MODE: MPEG LAYER 2         
AUDIO SAMPLE RATE: 48000 HZ STEREO     NO DE-EMPHASIS 
AUDIO BITRATE: 384 KBPS VARIABLE BITRATE or highest available value.   

Note that using lower bit rates will not save storage space as audio is 
uncompressed before storage.  Low rates adversely affect audio quality. 

MULTIPLEXING TYPE: MPEG-2          
 ALIGNED SEQUENCE HEADERS 
 TIMESTAMPS IN ALL FRAMES 
 SEQUENCE END CODES required. 
 PROGRAM END CODE required. 
PACK SIZE: 2048 BYTES 
STARTUP DELAYS: PACK=0, AUDIO=180, VIDEO=180.   

A/V offsets using these parameters are not supported. 
 

The Image Server does not support intermixing (playing back-to-back) material encoded Bottom 
Field First with that encoded Top Field First.  Top Field is the method used by the Image Server, 
therefore if both imported and recorded material are to be used together, imported material must 
be encoded Top Field First.  Bottom Field First can ONLY be used when all the material to be 
played on a particular channel is encoded that way, or in applications where clips are played one 
at a time. 
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Appendix O 

Mechanical Drawing 

Figure 32: Dimensional Drawing 
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